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Abstract 20 

Advances in tissue labelling and clearing methods include improvement of tissue 21 

transparency, better preservation of fluorescent signal, compatibility of immunostaining and 22 

feasibility for large sample volume. However, existing methods share the common limitation 23 

that they can only be applied to human tissue slices, thus rendering intact human organs 24 

transparent remains a challenge. In this work, we describe experimental details of the Small-25 

micelle-mediated Human orgAN Efficient clearing and Labelling (SHANEL) pipeline, that can 26 

be applied for cellular mapping of intact human organs. We have successfully cleared 27 

multiple human organs including kidney, pancreas, heart, lung, spleen and brain, as well as 28 

hard tissue like skull. This protocol illustrates the complete process of labelling and clearing 29 

whole human organs as well as handling corresponding large image datasets within weeks 30 

to months based on the organ types and sizes. 31 

 32 

Introduction 33 

Three-dimensional (3D) mapping of the human organs at cellular resolution and generating 34 

reference maps of organs across ages or diseases represent the common perspectives of 35 

diverse consortiums including HuBMAP (Human Biomolecular Atlas Program)1,2, Human Cell 36 

Atlas3, Human Tumour Atlas4, and LungMap5. Traditional histological techniques of slicing, 37 

staining, imaging and 3D reconstruction of cellular details of biological tissue pieces would 38 

receive feasibility and scalability challenges when dealing with big-sized human organs. For 39 

example, mapping one intact adult human brain took years of tedious work, not mentioning 40 

the mechanical distortion and accidental loss of sections during the lengthy process6. While 41 

improvements are being constantly developed in the apparatus and iterative image analysis 42 
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of multimodality imaging of human organs using PET/MRI, these modalities are still limited 43 

by low resolution and the lack of an ability to probe cellular and molecular parameters.  44 

 45 

Recently, extensive biomedical research including in neuroscience7-12, development13, and 46 

cancer14,15 significantly benefited from the optical tissue labelling and clearing methods that 47 

bypass major problems of histology. Especially, clearing and imaging of whole adult mouse 48 

bodies opened a holistic examination window into physiological and pathological systems in 49 

an unbiased way9,14. However, human organs obviously are much larger in size, and contain 50 

more complex tissue components due to aging, which are limiting the post-staining methods 51 

comparing to months-year old rodent organs. Therefore, whole human organ transparency 52 

has been challenging, despite numerous trials on slices11,16-19. Hence, we developed a full 53 

pipeline of whole human organ labelling, clearing, imaging and 3D map reconstruction at 54 

cellular level, which implemented a new tissue labelling and clearing technology termed 55 

SHANEL and an advanced volumetric imaging system from commercialized light-sheet 56 

fluorescence microscope (LSFM)20. This pipeline is easy-to-be-adopted in laboratories, within 57 

routine workload, flexible to achieve bona fide scalability (Fig. 1). 58 

 59 

Details of SHANEL method 60 

Clarifying the key challenges during the time-consuming endeavour of human organ 61 

processing is a prerequisite requirement. Here we delineate the main problems that pose to 62 

guide the development of our strategies in Table 1. 63 

 64 

Keeping all these questions in mind, we started with introducing the active perfusion system 65 

to deliver 0.01 M PBS/heparin and 4% PFA solutions into whole organs through vascular 66 

network before the organs harvest if resources are accessible (Fig. 2, Supplementary Fig. 67 

1a). The advantages of this step included washing out remaining blood as much as possible, 68 

circulating the vascular system before the forming of clots and faster tissue fixation than 69 

passive immersion. The organs were dissected carefully to preserve intact anatomical 70 

shapes and connect the main arteries with exogenous tubes for later experiments. 71 

Otherwise, human samples could be passively fixed in 4% PFA or 10% formalin buffer to 72 

covalently crosslink the proteins. It is worth mentioning that human organ and tissue donation 73 

organizations such as IIAM (international institute for the advancement of medicine) are 74 

reliable resources, which provide transplantable organs with intact vascular systems and 75 

detailed donor information.    76 

 77 

Among the hydrophilic reagent-based21-24, hydrogel-embedding19,25-27, hydrophobic reagent-78 

based9,10,13,14 tissue clearing methods, we chose to work with hydrophobic reagents for tissue 79 

clearing steps in the SHANEL pipeline. An important advantage of hydrophobic tissue 80 

clearing is sample shrinkage, enabling us to accommodate and image large organs using a 81 

light sheet fluorescent microscope. Ethanol was employed to get rid of the water inside of 82 

human tissue, by increasing serial ethanol concentration step wisely. Dichloromethane was 83 

used to extract the remaining lipid and ethanol, after which the tissue was mostly composed 84 

of fixed proteins. In the end, the relatively homogenous human tissue became transparent by 85 

immersing it into the BABB solution (benzyl benzoate: benzyl alcohol= 2:1, v/v) with a 86 

refractive index of 1.56, the same as that of the cross-linked proteins. In general, the 87 

hydrophobic reagents cleared organs will shrink ~30% in volume10,20. However, traditional 88 

commercialized LaVision UltraMicroscope II system (chamber size of 72 x 74 x 35 mm, 89 

sample traveling range of 10 x 10 x 10 mm in X,Y,Z)  or ZEISS Lightsheet 7 (sample size of 90 
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10 x 10 x 20 mm) cannot hold the large cleared human organs, such as an intact eye (size of 91 

30 x 30 x 30 mm). We co-designed together with Miltenyi Biotec and developed a prototype 92 

UltraMicroscope (chamber size of 250 x 90 x 70 mm) (Fig. 3). Then Miltenyi Biotec releases 93 

commercialized as UltraMicroscope Blaze (chamber size of 129 x 51 x 64 mm, sample travel 94 

range of 50 x 24 x 23 mm), fully automated light-sheet microscopes for imaging large cleared 95 

samples covering the range from entire mice to most human organs.  96 

 97 

Efforts to label and clear human brain pieces by screening with thousands of chemicals28 or 98 

employing extra forces17,19 have already shown the difficulties regarding to incomplete tissue 99 

transparency, time-consuming procedures and limited antibody penetration. Given that aged 100 

human tissue is composed of dense and intricate hydrophobic and hydrophilic molecules, we 101 

hypothesized that an efficient detergent permeabilization is necessary to render the human 102 

tissue accessible to reagents traveling end-to-end through it. Detergents are amphiphilic, 103 

possessing both hydrophilic and hydrophobic properties, and forming micelles in solutions 104 

that can interact with molecules of the tissue. Traditional detergents of ionic SDS (Sodium 105 

dodecyl sulfate) or non-ionic Triton X-100 (4-(1,1,3,3-Tetramethylbutyl)phenyl-polyethylene 106 

glycol), carrying typical ‘head-to-tail’ chemical structures, are inefficient at permeabilizing the 107 

sturdy human tissues because their micelle sizes are too big to enter deeply inside of tissue. 108 

We identified CHAPS (3-[(3-cholamidopropyl)dimethylammonio]-1-propanesulfonate) as a 109 

powerful candidate to completely and quickly permeabilize intact human organs, as it forms 110 

much smaller micelles with its special ‘facial’ chemical structure. CHAPS ameliorates the 111 

microenvironments of cellular and extracellular matrix of aged human tissue to make the 112 

intact human organs permeable and accessible by reagents. To remove the red colour of 113 

remaining blood clots, we screened diverse heme-eluting chemical analogues that are 114 

compatible with CHAPS. Analogues bearing ethanolamine structures have improved 115 

decolorization effects in the presence of CHAPS20. Although potential candidates such as N-116 

Butyldiethanolamine28 and N,N,N’,N’-tetrakis(2-hydroxypropyl)ethylenediamine (Quadrol)24 117 

have been proved to be efficient in decolorizing, but they are at least 2 times more expensive 118 

than N-methyldiethanolamine (NMDEA) (~30 €/ liter). Considering the intact human organs 119 

consume a large amount of decolorization chemical agents, we decided to use a NMDEA 120 

and CHAPS mixture to achieve the permeabilization and decolorization to reduce the cost. 121 

Still, the volume of the reagents consumed in a single step of handling an intact human brain 122 

was around 5-6 L, and the total cost of all chemicals was about 3200 Euro20. 123 

 124 

Small molecular dyes (<1-2 kDa) or large molecular antibodies (~150 kDa) provide 125 

fluorescent contrast of signal-to-background to identify specific structures of human tissue. 126 

DNA or RNA chemical probes show high binding specificities and affinities to the nucleic acid 127 

of cells across a wide range of fluorescent spectra (e.g. DAPI, Hoechst in blue-green range; 128 

JO-PRO-1, PI in green-red range; TO-PRO3, SIR in red range)29. Furthermore, chemical 129 

fluorochromes conjugated primary or secondary antibodies cannot penetrate and label more 130 

than 1 cm deep into the adult human organ due to their big sizes. Hence, we introduced 131 

chemical pre-treatments to loosen the cellular and extracellular matrix. First, a solvent 132 

mixture of dichloromethane/methanol (2:1, v/v) was used to extract the hydrophobic lipids 133 

inside the tissue which would repeal the free movement of hydrophilic labelling reagents 134 

dissolved in buffer30. Second, the tissue was subjected to acetic acid for partial hydrolysis of 135 

intertwined collagen by cleavage of the non-covalent intra- and inter-molecular bonds31. This 136 

process maintains the collagen chains intact, but the cross-links are cleaved. Third, 137 

guanidine hydrochloride buffer was employed to extract the proteoglycans of tissue in 138 
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dissociative conditions32. After these chemical extraction steps, the spatial interval of tissue 139 

matrix became accessible to both small molecular dyes and large molecular antibodies at a 140 

depth range centimetres. Cell nuclei in intact human pancreas were perfused and labelled 141 

with PI (Fig. 4). Vasculature in multiple human organs was labelled with dextran solution (Fig. 142 

5). SHANEL is also compatible with passive incubation of dye and antibodies to stain PFA 143 

fixed human tissue up to centimetres size range (Fig. 6). As we have previously 144 

demonstrated, 1.5 cm cubic human brain pieces were successfully labelled with primary 145 

antibody and secondary antibody for cellular (e.g. Iba1) and molecular (e.g. tyrosine 146 

hydroxylase) structures20. Eventually, antibody conjugated with large protein dyes (e.g. 147 

phycoerythrin) also fully labelled more than 1 cm cubic human kidney and lung pieces to 148 

present cytoplasmic (e.g. Catalase), extracellular (e.g. Collagen IV),and membranous (e.g. 149 

cytokeratin 19) structures of tissue (Supplementary Fig. 2 and Table 2).   150 

 151 

With the prototype or commercial UltraMicroscope Blaze, it is possible to scan the intact 152 

human eye, kidney, thyroid and pancreas by mosaic imaging. The scanning time depends on 153 

the size of the sample, the overlapping percentage of the mosaic, the number of scanning 154 

channels and the settings of the Z step (Supplementary Fig. 3). Correspondingly, terabytes 155 

of large data can be generated from a single organ. Software such as Fiji, Arivis, Imaris and 156 

Photoshop can be used to handle the large data for 3D reconstruction and movie generation 157 

with a standard lab workstation (e.g., > 256 gigabytes of RAM and terabytes of storage 158 

space) (Supplementary Fig. 4-6). However, quantitative analysis of such large data can be 159 

difficult and imprecise using such software, which in general relies on simple strategies such 160 

as filter-based normalization, thresholding or watershed algorithms. Recently, deep leaning 161 

approaches14,20,33 have shown superior performances in quantification of large-scale data in 162 

terms of processing accuracy and speed. It is anticipated that 3D human organ mapping 163 

could be greatly advanced with a full exploitation of combing tissue clearing and imaging with 164 

deep learning technologies.  165 

 166 

Adaptive applications of SHANEL 167 

Mammalian skeletal bones shelter diverse special physiological dynamics and functions 168 

across the whole body system. An expanding exploration of deep tissue labelling, clearing 169 

and imaging of bones using SHANEL would greatly benefit to investigate the 3D geometric 170 

features of bone volume and cells. In addition to the soft tissues such as bone marrow, 171 

bones contain hard mineral-dense regions that are deposited with calcium-bearing 172 

hydroxyapatite crystals in collagen matrix. The calcium content considerably induces optical 173 

scattering of bone34. EDTA has been demonstrated as an efficient decalcification reagent in 174 

previous studies35,36. Similarly, Tainaka et al developed a carbonated hydroxyapatite-based 175 

screening system to identify potent decalcification chemicals compatible with the tissue 176 

clearing and found EDTA combining with imidazole showed superior effects28.  Hence, we 177 

conducted decalcification of bones using 20% EDTA at 37ºC before SHANEL tissue labelling 178 

and clearing, as shown with examples of human skull pieces and pulvinar soft tissue inside 179 

the joint cartilage surface surrounded by bones (Fig. 7). Human bone samples are much 180 

thicker and harder than mouse ones, which would take much longer time to achieve the 181 

desired softness, in the range of weeks to months. There are alternative decalcification 182 

reagents composed by strong, mild or weak acids (e.g. nitric acid, formic acid, hydrochloric 183 

acid, chromic acid etc.). It is claimed that 5% nitric acid is an option for rapid decalcification 184 

while yielding acceptable tissue integrity and antigenicity37,38.  185 

 186 
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SHANEL tissue clearing methods have been proven to be applicable to other mammalian 187 

species such as pig brain, pig pancreas and be compatible with vDISCO immunostaining20. 188 

This would enable imaging large mammalian organs that are expressing fluorescent proteins 189 

such as GFP, YFP, mCherry, and tdTomato. Since fluorescent protein labeling of cells are 190 

widely used including in zebrafish, rat, mouse, pig, and macaque, SHANEL can readily be 191 

adopted to clear and image diverse organisms. In such a case, the organs are first, actively 192 

perfused or passively incubated with the mixture of CHAPS and NMDEA to permeabilize and 193 

decolorize tissue. Afterwards, vDISCO immuostaining process is used via 194 

perfusion/incubation with the chosen nanobody in a solution of 1.5 vol% goat serum, 0.5 195 

vol% Triton X-100, 0.5 mM of methyl-β-cyclodextrin, 0.2 wt/vol% trans-1-acetyl-4-hydroxy-L-196 

proline and 0.05 wt/vol% sodium azide in PBS. Finally, the organs become ready to clear by 197 

SHANEL reagents. It is anticipated that after CHAPS and NMDEA treatment, 198 

nanobody/antibody immunolabeling and SHANEL tissue clearing could be applied to diverse 199 

mammalian species to investigate broad biological questions. In cases where antibody-200 

based tissue labelling fails due to its size-limited inability to cross through whole organs, ten 201 

times smaller nanobodies could provide a more viable alternative. 202 

 203 

Although the SHANEL tissue labelling and clearing method is developed for intact human 204 

organs, it also works for small tissue pieces, for example on human biopsies. In general, 205 

biopsy samples are small in size and suitable for the application of the passive SHANEL 206 

labelling and clearing method.  207 

 208 

Comparison with other methods 209 

In the last years, researchers reported their works of labelling and clearing of human organ 210 

pieces by diverse methods including CLARITY17,39, OPTIClear16, MASH18, CUBIC28, 211 

SWITCH40, SHIELD11 and ELAST19. CLARITY and OPTIClear took months to clear fixed 212 

human brain tissue pieces (<5 mm thickness). MASH explored the small-molecule 213 

fluorescent dye labelling and clearing of human brain cortex (< 5 mm thickness) by modifying 214 

the iDISCO protocol. Other methods were applicable to 3D imaging of human myocardial 215 

tissue41, lymph node and lung pieces (< 1cm3)42. SWITCH allowed multiple rounds of 216 

antibody labelling in 100 um thick human brain section. Based on SWITCH method, SHIELD 217 

used tissue transformation strategy to stabilize 2 mm thick human brain slice via 218 

intramolecular epoxide linkages to prevent degradation. ELAST enabled human brain tissue 219 

(< 5 mm thickness) antibody labelling and clearing by mechanically stretching tissue-220 

hydrogel hybrids. The key step of the SHANEL technology relied on the permeabilization and 221 

decolorization by CHAPS/NMDEA solution.  222 

 223 

For the first time, SHANEL technology achieved the labelling and clearing of intact adult 224 

mammalian organs of centimetres sizes, including human brain, pig brain, pig pancreas, 225 

human kidney, human thyroid20, human heart, human pancreas, human lung and spleen (Fig. 226 

5). The whole process can be conducted by passive incubation or active perfusion, 227 

depending on the availability of main vessels for external connection to commercialized 228 

pumps. This could scale up the process to numbers of organs, with simple set-up in standard 229 

labs, and no special expertise or training required to implement. It is preferred to perform 230 

active perfusion for large adult organs, in order to speed up the process to a reasonable 231 

period (e.g. 1.5 months for human kidney, 4 months for human brain). The timeline for each 232 

step varies case by case depending on the specific organs. Even a pair of kidneys from the 233 

same donor could be different in size, hardness, blood clots and pigments accumulation. The 234 
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organs should be assured to completely fulfil the target of each step of permeabilization and 235 

decolorization, delipidation, cellular and extracellular matrix loosening and labelling, 236 

dehydration and refractive index matching.  237 

 238 

Experimental design 239 

SHANEL provides a flexible platform for diverse human organ resources to achieve whole or 240 

partial organ labelling, clearing, and imaging at a cellular level (Fig.1, Supplementary Fig. 7). 241 

The whole pipeline is focused on the main steps: (i) preparation of fixed organs according to 242 

the donor (steps 1-2);  (ii) sample pre-treatment, including optional steps such as 243 

decalcification and blood vessel labelling (steps 3-7); (iii) labelling with chemical probes or 244 

antibodies (steps 8-14); and  (iv) tissue clearing and imaging with light-sheet microscopy 245 

(steps 15-17).  246 

 247 

Expertise needed to implement the protocol 248 

We would recommend people with knowledge from the biological, medical, or human 249 

anatomical background or with previous experience in handling commercial light-250 

sheet microscopes to implement this protocol. With the skills of using Fiji, Imaris, and 251 

Arivis software, it will be more quickly to master this method. 252 

 253 

Limitations of the current SHANEL pipeline 254 

As most of the tissue clearing methods, the SHANEL tissue labelling and clearing protocol 255 

includes the delipidation step, which cannot be compatible with fluorescent lipophilic dyes, 256 

such as DiI. One possibility is using modified DiI-analogues, for example CM-DiI, SP-DiI or 257 

FM 1-43FX, that could be covalently attached to tissue proteins during aldehyde-fixation. 258 

These dyes would adhere to the cellular membranes and proteins, even after lipid clearing43.  259 

 260 

Another issue that we have to take into consideration is the fact that blood clots and 261 

lipofuscin cause strong autofluorescence in human samples. The accumulation of lipofuscin 262 

is associated with the process of ageing44. Its presence would complicate the analyses of 263 

specific fluorescence labelling. It has been reported to reduce or eliminate autofluorescence, 264 

without adversely affecting the targeted labels, by chemical treatment45-47 (e.g. CuSO4, 265 

Sudan Black B, NaBH4) or photobleaching19. We found that CuSO4 was greatly efficient in 266 

reducing the lipofusin autofluorescence whilst being compatible with labelling. However, due 267 

to the natural blue color of CuSO4 solution, the sample color could be light blue after 268 

treatment depending on the concentration of CuSO4 solution, which would partially absorb 269 

the laser light energy used during imaging. Therefore, there is a compromise of fluorescence 270 

signal-to-background ratio when decreasing the autofluorescence signal. In the future, it 271 

would be valuable to identify a colorless, efficient chemical to remove autofluorescence in the 272 

SHANEL protocol.  273 

 274 

Furthermore, an additional necessary step is the validation of new antibodies, nanobodies or 275 

dyes before their application within large organs. Human organs have to be pre-treated with 276 

diverse chemicals to loosen the extracellular matrix to allow the antibody or nanobody travel 277 

inside. These chemicals would potentially affect the binding of antibody/nanobody with target 278 

antigen epitopes of human samples. Nevertheless, positive staining after SHANEL method 279 

indicates that the antibody target is well-preserved and specific when comparing the result 280 

with previous traditional immunostaining paper. Abundantly commercialized 281 

antibodies/nanobodies often require rigorous in-house validation. A well-accepted way of 282 
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quickly selecting an antibody compatible, sensitive, and specific with SHANEL, our 283 

experience is to choose a research antibody that has been listed in the top-cited ranks in a 284 

searchable antibody database48. Commonly, human samples firstly go through all pre-285 

treatment steps of CHAPS/NMDEA, delipidation and ECM loosening in SHANEL, then 286 

samples were subjected to traditional slicing technique (e.g. cryostat) to generate lots of thin 287 

sections (e.g. 10-50 µm). With these sections, the product lot, optimized working 288 

concentration and staining conditions were identified. An antibody provides a good signal in 289 

tissues sections, which always indicates it has a good chance of being compatible with 290 

SHANEL. As mentioned before, confirmed labelling reagents in the lab were summarized in 291 

Table 2.  292 

 293 

Although the SHANEL tissue labelling and clearing technology is capable to turn human 294 

organs as large as the intact brain transparent, current light-sheet fluorescent microscopy 295 

have a limited capacity to image all big human organs. In addition, especially for volumetric 296 

imaging of whole organs with long-working distance objectives, the current commercial light-297 

sheet microscopes face the problem of poor resolutions in Z, which lead to inevitable non-298 

isotropic volumetric images. In general, whole organ imaging reconstruction data got less 299 

influence of non-isotropic volumetric images by quantitative analysis of mesoscale structure. 300 

Light-sheet microscope such as MesoSPIM is integrated with a moving-waist beam and can 301 

improve the resolution, especially in the Z dimension49. The SHANEL method didn't include 302 

eliminating the signal from the antibodies stained, and we didn't try the multiple rounds of 303 

antibodies relabeling. Efforts on optimized SHANEL method for multiple round labelling of 304 

antibodies will also be made. 305 

  306 
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Materials 307 

Human organ materials 308 

All human organs were taken from different human body donors. All donors gave their 309 

informed and written consent to explore their cadavers for research and educational 310 

purposes, when still alive and well. The signed consents are kept at the Anatomy Institute, 311 

University of Leipzig, Germany. Institutional approval was obtained in accordance to the 312 

Saxonian Death and Funeral Act of 1994. The signed body donor consents are available on 313 

request. 314 

• Human kidney, pancreas, pulvinar and human brain with skull were dissected from an 315 

88-year-old female donor. 316 

• Human heart, lung, spleen and pancreas for vessel labelling were from a 79-year-old 317 

female donor. 318 

• Brain slices for immunolabeling were from an 86-year-old female. Lung and kidney 319 

tissue for immunolabeling were from a 97-year-old female donor. 320 

 321 

Reagents 322 

• 1x Phosphate-buffered Saline (PBS) (diluted from 0.1 M stock solution, Apotheke 323 

Klinikum der Universität Munchen, cat. no. P32799)  324 

• Deionized water (diH2O, in house purification system) 325 

• 4% PFA in 1x PBS solution (4 wt/vol%; pH 7.4, Morphisto, cat. no. 11762.01000) 326 

!CAUTION Toxic reagent. ▲CRITICAL store at 4°C and do not use it when expired. 327 

• Heparin (Braun, 25000 IE/5ml) 328 

• Tetramethylrhodamine isothiocyanate–Dextran (mw 500000, Sigma-Aldrich, cat. 329 

no.52194)  330 

• p-maleimidophenyl isocyanate (PMPI) (ThermoFisher, cat. no. 28100) !CAUTION 331 

Eye and skin irritation. 332 

• Dithiothreitol (DTT) (Sigma-Aldrich, cat. no.43815) !CAUTION Eye, skin and 333 

respiratory irritation.  334 

• Propidium Iodide (PI) (ThermoFisher, cat. no. P1304MP) 335 

• 3-[(3-cholamidopropyl)dimethylammonio]-1-propanesulfonate (CHAPS) (Carl Roth, 336 

cat. no.1479.4) !CAUTION Light powder, avoid inhalation. ▲CRITICAL store at 4°C 337 

and do not use it when expired. 338 

• N-methyldiethanolamine (NMDEA) (Sigma-Aldrich, cat. no.471828) !CAUTION Eye 339 

irritation. 340 

• Guanidine hydrochloride (Carl Roth, cat. no. 6069.3) !CAUTION Skin and eye 341 

irritation. 342 

• Acetic acid (Carl Roth, cat. no. T179.1) !CAUTION Danger of flammable and 343 

corrosive. Skin and eye damage. 344 

• Sodium acetate (Sigma-Aldrich, cat. no. S2889) ▲CRITICAL Storage separated from 345 

strong acids and strong oxidants. 346 

• Triton X-100 (PanReac Applichem, cat. no. A4975,1000) !CAUTION Danger of 347 

corrosive, irritant and environmental hazard. Skin and eye damage. 348 

• 2-Hydroxypropyl-beta-cyclodextrin (HPCD, PanReac Applichem, cat. no. 349 

A0367,0100) 350 

• DMSO (Carl Roth, cat. no.  A994.2) !CAUTION skin and eye irritation. 351 

• NaOH (Carl Roth, cat. no. 6771.1) !CAUTION Danger of corrosive. Skin and eye 352 

damage. 353 
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• Ethanol (Merck, cat. no. 10098535000) !CAUTION Danger of flammable. 354 

• Methanol (Carl Roth, cat. no. 4627.6) !CAUTION Danger of flammable, acute toxic 355 

and health hazard. Toxic reagent. 356 

• Dichloromethane (DCM, Carl Roth, cat. no. KK47.1) !CAUTION Health hazard. 357 

Evaporate.  358 

• BABB (benzyl benzoate:benzyl alcohol = 2:1, Sigma-Aldrich, cat. no. W213802, cat. 359 

no. 24122) !CAUTION Irritant and environmental hazard. 360 

• Sodium azide (Sigma-Aldrich, cat. no. 71290) !CAUTION Danger of acute toxic and 361 

environmental hazard. 362 

• Goat serum (GIBCO, cat. no. 16210072) 363 

• Copper sulfate (CuSO4, Carl Roth, cat. no. CP86.1) 364 

• Ammonium chloride (Carl Roth, cat. no. P726.1) 365 

 366 

Equipment 367 

• Surgery scissors (FST, cat. no. 14958-11) 368 

• Big Metal Tweezers (FST,  cat. no. 11000-20) 369 

• Fine Metal Tweezers (FST, cat. no. 11252-40) 370 

• peristaltic pump (ISMATEC, REGLO Digital MS-4/8 ISM 834) 371 

• PTFE tubing (VWR, 228-0735) 372 

• Reference tubing for the ISMATEC peristaltic pump (ISMATEC, cat. no. SC0026) 373 

• Glass chamber (Omnilab, cat. no. 5163279) 374 

• Glass chamber ( LABICAT, cat. no. 40070360, 40070180) 375 

• Shaking rocker (IKA, 2D digital). 376 

• Shaker (IKA, model KS 260 basic) 377 

• 5 ml tubes (Eppendorf, cat. no. 0030 119.401) ▲CRITICAL highly recommend due to 378 

the resistance to clearing solutions 379 

• 15 ml tubes (Thermo Fisher Scientific, cat. no. 339651) ▲CRITICAL highly 380 

recommend due to the resistance to clearing solutions 381 

• 50 ml tubes (Thermo Fisher Scientific, cat. no. 339653) ▲CRITICAL highly 382 

recommend due to the resistance to clearing solutions 383 

• 1 L glass beakers (any, we used the ones from DURAN) 384 

• 1 L glass bottles (any, we used the ones from DURAN) 385 

• 2 L glass bottles (any, we used the ones from DURAN) 386 

• 500 ml glass bottles (any, we used the ones from DURAN) 387 

• PTFE covered magnetic stirring bars (any) 388 

• Hot magnetic stirrer (IKA, model RCT basic B-5000, cat no. 0003810000) 389 

• Aluminium foil (any) 390 

• Plastic wrap (any) 391 

• Disposable underpads (Medimex, cat no. E1911804, or any) 392 

• Syringes of 1 ml, 5 ml, 10 ml, 50 ml (any) 393 

• Tapes, black and transparent ones (any) 394 

• Parafilm (Bemis, cat. no. PM-992) 395 

• pH meter (WTW, model pH7110) 396 

• Shaking rocker (IKA, model 2D digital) 397 

• Incubator (Memmert, model UN160), although any incubator that reaches keeps 37°C 398 

with a shaker inside is fine 399 

https://www.sigmaaldrich.com/catalog/substance/dichloromethane84937509211
https://www.sigmaaldrich.com/catalog/substance/dichloromethane84937509211
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• Fume hood 400 

 401 

Imaging systems 402 

• Computer equipped with light-sheet microscope (Processors: Intel Core i7-7800X 403 

CPU @ 3.50GHz; graphic card: NVIDIA Quadro K420; random access memory: 404 

32GB;  solid state drive: Samsung SSD 860 PRO 1TB; hard disk drive: Seagate 405 

Enterprise Capacity SATA 12TB (ST12000NM0007); operation system: Windows 10 406 

Pro, 64 bit.) 407 

 408 

Miltenyi Biotec UltraMicroscope II light-sheet microscope coupled with: 409 

• SuperK EXTREME/FIANIUM supercontinuum white light laser (NKT Photonics, model 410 

SuperK EXTREME EXW-12) 411 

• Andor sCMOS camera Neo 5.5 (Andor, mod. no DC-152Q-C00-FI) 412 

• Filter sets: ex 470/40 nm, em 535/50 nm; ex 545/25 nm, em 605/70 nm; ex 413 

560/30 nm, em 609/54 nm; ex 580/25 nm, em 625/30 nm; ex 640/40 nm, em 414 

690/50 nm 415 

• Olympus MVX10 zoom body (zoom range 0.63x-6.3x) 416 

• Olympus revolving zoom body unit (U-TVCAC) 417 

• 1x air objective (Olympus MV PLAPO ×1/0.25 NA, WD = 65 mm) 418 

• 2x immersion objective (Olympus MVPLAPO2XC/0.5 NA, WD = 6 mm) 419 

• 4x immersion objective (Olympus XLFLUOR ×4 corrected/0.28 NA, WD = 10 mm) 420 

• 12x immersion objective (Lavision MI PLAN 12x /0.53NA, WD = 10mm) 421 

• 20x immersion objective (Zeiss ×20 Clr Plan-Neofluar/0.1 NA, WD = 5.6  mm) 422 

 423 

Miltenyi Biotec prototype UltraMicroscope light-sheet microscope for large samples coupled 424 

with: 425 

• LASOS Multi Color System Series for the laser box (LASOS, model MCS5 F2-01) 426 

• Andor sCMOS camera Zyla 5.5 (Andor, mod. no ZYLA-4.2P-CL10) 427 

• Filter sets: ex 488 nm, em 525/50 nm; ex 561 nm, em 595/40 nm; ex 640 nm, em 428 

680/30 nm; ex 785 nm, em 845/55 nm 429 

• Olympus revolving zoom body that can switch between 1x and 2x with an autofocus-430 

Cube AFC-UM2-UBG 431 

• 1.1x objective (LaVision MI PLAN x1.1/0.1 NA, WD = 17 mm) 432 

 433 

Zeiss LSM 880 inverted laser-scanning confocal microscope coupled with 434 

• 25x water-immersion objective (Leica, x25/0.95 NA, WD = 2.5 mm) mounted with a 435 

custom mounting thread.  436 

 437 

▲CRITICAL Check the compatibility of the microscope and objectives of different brands 438 

with the vendors. 439 

 440 

Computer and Data processing and analysis tools 441 

• Computer (HP Z840 workstation; Windows 10 Pro, 64 bit; CPU: Intel Xeon E5-2640 442 

v3; Installed memory: 256GB; GPU: NVIDIA Quadro M5000) 443 

• Fiji (ImageJ2, https://fiji.sc/) for stitching original mosaic tiffs from light-sheet 444 

microscope 445 

https://fiji.sc/
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• Total Commander (v. 8.52a x64, https://www.ghisler.com/) for rename the file names 446 

of stitched tiffs 447 

• ImageMagick (v. 7.0.5-4, https://imagemagick.org/script/index.php) for Lempel-Ziv-448 

Welch (LZW) TIFF compression 449 

• Vision4D (v.3.0.1 ×64, Arivis) for fusing intact organs from multiple scans 450 

• Arivis converter (v.2.12.6, Arivis) 451 

• Imaris (Bitplane) for visualization of 3D images 452 

• Photoshop CS6 (v. 13.0, Adobe)  453 

 454 

Reagent setup 455 

Dextran vessel labelling solution 456 

Tetramethylrhodamine isothiocyanate–Dextran is a commonly used dye to trace vessels in 457 

vivo. To chemically fix dextran inside the vessels, we used p-maleimidophenyl isocyanate 458 

(PMPI) and DL-dithiothreitol (DTT) to crosslink the hydroxyl group of dextran to the surround 459 

sulfhydryl-containing proteins. The working solution of dextran is containing 5 mg/ml 460 

tetramethylrhodamine isothiocyabate-dextran, 0.4 mM PMPI and 1 mM DTT in PBS. For 461 

example, as shown in the following table, each reagent is prepared separately. 1) dissolve 462 

8.6 mg PMPI in 2 ml DMSO; 2) dissolve 15.4 mg DTT in 5 ml PBS; 3) dissolve 0.5 g dextran 463 

in 93 ml PBS. Mixing all solutions together before the perfusion. (See Table 3) 464 

▲CRITICAL Prepare fresh solutions before starting the experiment. !CAUTION Prepare the 465 

solutions in hood and wear mask. 466 

 467 

EDTA solution 468 

EDTA decalcification solution is prepared with 20% (w/v) EDTA in diH2O, adjusting the PH to 469 

8.0-8.5 using NaOH or HCl. For example, in a 2L bottle with stirring bar, dissolve NaOH 470 

continuously to keep 1.5 L diH2O alkaline, then slowly add 400 g EDTA powder. Replenish 471 

diH2O, more NaOH or HCl until reaching 2L with PH of 8.0-8.5. !CAUTION If EDTA 472 

precipitation happens, adding more NaOH until the solution becomes transparent.  473 

 474 

CHAPS/NMDEA solution 475 

CHAPS/NMDEA mixture is composed of 10% (wt/v) CHAPS and 25% (wt/v) NMDEA (N-476 

methyldiethanolamine) in diH2O. For example, in a 2 L bottle, mix 200 g of CHAPS and 500 g 477 

of NMDEA in diH2O with a stirrer at room temperature (22-25 ºC) and set the final volume to 478 

2 L. The reagent could be stored at 4 ºC for several months. !CAUTION CHAPS is a light 479 

powder, it is suggested to wear mask to avoid inhalation during process. 480 

 481 

Acetic Acid solution 482 

Acetic acid solution is 0.5M in diH2O. For example, in a 1L bottle, mix 30 mL acetic acid in 483 

diH2O at room temperature (22-25 ºC) and set the final volume to be 1 L. The reagent could 484 

be stored at room temperature for several months. !CAUTION Prepare the solution in hood 485 

and wear mask due to the smell of acetic acid. 486 

 487 

Guanidine solution 488 

Guanidine solution is a mixture of 4 M guanidine hydrochloride, 0.05 M sodium acetate and 489 

2% Triton X-100 in PBS, pH=6.0. For example, in a 2 L bottle, mix 764.2 g guanidine 490 

hydrochloride, 8.2 g sodium acetate and 40 g Triton X-100 in PBS with a stirrer at room 491 

temperature and set the final volume to 2 L. Adjust the PH to 6.0 with 4M NaOH solution and 492 

https://www.ghisler.com/
https://imagemagick.org/script/index.php
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30% hydrochloric acid solution. The reagent could be stored at room temperature for several 493 

months.  494 

 495 

Dehydration and rehydration solutions 496 

A series of dehydration solutions are prepared by mixing ethanol with diH2O for 50%, 70%, 497 

100% (v/v). It is suggested to prepare the solutions in fresh before using.  498 

 499 

Delipidation solutions 500 

The delipidation solution could be DCM/MeOH mixture or pure DCM solution. For tissue pre-501 

treatment before labelling, it is mixture of 2 volume of DCM and 1 volume of MeOH. For 502 

tissue clearing after labelling, pure DCM is used. !CAUTION DCM is health hazard and 503 

highly volatile. It should be handled in a fume hood by wearing safety goggles and double 504 

layer nitrile gloves to avoid inhalation and contact with skin/eyes. ▲CRITICAL Prepare fresh 505 

solution before using it. 506 

 507 

Sodium Azide stock solution 508 

The concentration of sodium azide stock solution is 0.05% (wt/v) dissolving into 1x PBS. This 509 

solution can be stored at 4 °C for several months. !CAUTION Avoid contact with skin and 510 

eyes. 511 

 512 

Blocking buffer for antibody staining 513 

The blocking buffer contains 0.2% (v/v) Triton X-100, 10% (v/v) DMSO and 10% (v/v) goat 514 

serum in 1x PBS. For example, in a 500 ml bottle, mix 1 ml Triton X-100, 50 ml DMSO and 515 

50 ml goat serum in PBS with a stirrer at room temperature. ▲CRITICAL Prepare fresh 516 

solution before using it. The pre-treated tissue samples could be stored in blocking buffer at 517 

4 °C if adding 0.01% (w/v) sodium azide for several weeks before antibody staining. 518 

 519 

Antibody incubation buffer 520 

The antibody incubation buffer could be composed by 3% (v/v) goat serum, 3% (v/v) DMSO, 521 

0.2% (v/v) Tween-20 and 10 mg/L Heparin in 1x PBS or by 10% (w/v) HPCD, 3% (v/v) goat 522 

serum and 10 mg/L Heparin if the antibody water-solubility is poor. ▲CRITICAL Prepare 523 

fresh solution before using it. 524 

 525 

Antibody washing buffer 526 

The antibody washing buffer is prepared by 0.2% (v/v) Tween-20 and 10 mg/L Heparin in 1x 527 

PBS. This solution can be stored at 4 °C for several months. 528 

 529 

Copper sulphate (CuSO4) solution 530 

The copper sulfate solution can be used to eliminate tissue autofluorescence. Dissolve 1.6 g 531 

CuSO4 and 2.67 g ammonium chloride in diH2O, adjust pH to 5.0 and set the final volume to 532 

1 L. 533 

 534 

RI matching solution 535 

BABB is the RI matching solution, which is composed by benzyl alcohol and benzyl benzoate 536 
with a ratio of 1:2 in volume. BABB solution should be prepared and stored within glass 537 
container at room temperature in a fume hood. !CAUTION Benzyl benzoate is harmful if 538 
swallowed, and cause skin and eye irritation. Benzyl alcohol is harmful is swallowed and 539 
inhaled. In hence, handling must be operated by wearing safety goggles, nitrile gloves 540 
(preferably double layer) and lab coats. 541 
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 542 

Equipment setup 543 

Pump system 544 

In active perfusion system, the setting-up are constituted by an Ismatec peristaltic pump and 545 

connected tubes. This pump allows four channels as needed (Fig. 2, Supplementary Fig. 1). 546 

 547 

Procedure 548 

Preparation of fixed human organs ● Timing 1-2 d 549 

1. Human organs perfusion with PBS/heparin and PFA fixation. 550 

i. According to the anatomy characteristic of the human organs, use diameter 551 

size-matched plastic tubes stitching in the opened arteries and veins. 552 

!CAUTION Identify any risk factors for acute transmission before human 553 

organ handling. 554 

ii. At room temperature, using a gravitation irrigator system sets up the irrigator 555 

height as 0.5m to perfuse the human organs. Marker the start level of 556 

PBS/heparin (2.5U heparin per milliliter) solution of the irrigator and perfuse 557 

via the plastic tubes with PBS/heparin solution for 3-5 hours until the blood is 558 

flushed out with the sign of specimens changed their color to bright. It takes 559 

50 liters of such PBS/heparin solution for a heart-lung block and 20 liters for 560 

smaller organs such as kidneys, spleens, or brains.  561 

iii. Switch the PBS/heparin solution and continue to perfuse with 4% PFA solution 562 
for 15 minutes. Control the perfusion speed by setting up the irrigator height 563 
as 0.5m. It takes 20 liters per lung/hearth block and 10 liters for the kidneys, 564 
spleens, or brains. !CAUTION If there was no noticeable flow from the human 565 
organs, lift the irrigator to increase the perfusion speed (maximal 1.2 m height). 566 
A fume hood is necessary when working with formalin solution, which is toxic 567 
with a strong, pungent odor. 568 

iv. Post-fix the human organs with a 10 times volume 4% PFA solution for 7 569 

days. !CAUTION  The duration of fixation can affect sample integrity. Optimal 570 

fixing conditions should be assessed for each organ and tissue to prevent 571 

underfixation or overfixation. 572 

2. Wash the PFA-fixed human organ for following experiments. 573 

If perfusion applicable, under a fume hood, set up the pump perfusion system with 574 

connecting tubing on a layer of disposable pads. Put PFA fixed human organs in a 575 

proper glass container and actively perfuse with enough PBS at room temperature for 576 

at least three times. The speed of pump is 45-46 rpm (160–170 mmHg), and flow rate 577 

is 12.5 ml/min. If not applicable, under a fume hood, put a layer of disposable pads on 578 

the shaker. Put PFA fixed human organs in a proper glass container or falcons and 579 

passively incubate with enough PBS at room temperature at least three times. The 580 

speed of shaker is 50 rpm. 581 

!CAUTION The connect points of tubing can be protected or sealed with parafilm 582 

if needed.  583 

■ PAUSE POINT The fixed human organs could be stored at 4 ºC in PBS with 584 

0.01% (wt/vol) sodium azide.  585 

 586 

Organ pre-treatment according to experimental needs ● Timing 1-14 d 587 

3. In this step, we use different methods to treat different kind of human organs. If the 588 

organ vasculature is well preserved, we can perfuse it with dextran vessel labelling 589 
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solution. EDTA decalcification is needed in case there is bone tissue to be labelled 590 

and cleared. 591 

(A) Vessel labelling with dextran by perfusion (optional) ●  Timing 1 d 592 

(Figure. 2) 593 

i. Set up the pump perfusion system with connecting tubing on a layer of 594 

disposable pads. Put human organ in an empty and clean glass 595 

container, then perfuse it with fresh dextran working solution through 596 

each of the organ-inserted tubing until the solution is leaking out, which 597 

means the full filling of dextran solution. The speed of pump is 45-46 598 

rpm (160–170 mmHg), and flow rate is 12.5 ml/min. The leaking 599 

solution can be collected in a container and reused for another round 600 

of perfusion labelling.  601 

▲CRITICAL Ensure the organ turn red after dextran injection 602 

ii. After completing vessel labelling, wash the surface of human organ 603 

with running water to get rid of the unspecific contaminations from the 604 

leaking solution. !CAUTION If there is extra dye solution coming out 605 

from organ, wipe dry with paper to keep the whole organ surface clean 606 

from dye solution. 607 

iii. Put the labelled human organ in a plastic bag and seal with tape. 608 

iv. Put the plastic bag with labelled organ in a container and put them in 609 

37 °C incubator overnight.  610 

v. Take the human organ out and put it into enough PBS at room 611 

temperature for washing. 612 

? TROUBLESHOOTING 613 

(B) Decalcification with EDTA (optional) ● Timing 7-20 d 614 

Incubate human organs with bone tissue in 20% (wt/vol) EDTA (PH≈8.0) 615 

with 0.01% (wt/vol) sodium azide solutions at 37 ºC. Refresh the solution 616 

every 3-5 days until the bone part gets soft, then wash with PBS. 617 

!CAUTION EDTA crystals could be precipitated if not sealing well.  618 

 619 

Permeabilization and decolorization with CHAPS/NMDEA ● Timing 3-20 d   620 

4. If perfusion applicable, continue same pump perfusion system with enough 621 

CHAPS/NMDEA solutions to cover the organ for days-month at room temperature, 622 

refresh the solution when the solution get green or dark green colour for 2-3 times, 623 

until the solution does not change colour anymore. The glass chamber is covered 624 

with plastic wrap and aluminium foil to avoid the evaporation of water and light 625 

illumination under fume hood (Supplementary Fig. 1c-d).  626 

? TROUBLESHOOTING 627 

5. If not applicable with perfusion, continue with the passive incubation on the shaker. 628 

Incubate the organs with enough CHAPS/NMDEA solutions to cover the organ for 629 

days at 37 °C, refresh the solution when the solution get green or dark green colour 630 

for 2-3 times, until the solution does not change colour anymore.  631 

!CAUTION The reference tubing should be displaced back and forth to different 632 

sever-sections every 2 days to avoid the laxation or clamminess after long-term 633 

non-stopping abrasion. Check the tubing quality carefully time to time, it 634 

happened that the perfusion solution leaked from the wound of tubing if there was 635 

accumulation of abrasion from continuous pump running, especially during the 636 
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evening time without inspection. The disposable pads were helpful and easy for 637 

cleaning up when leaking accident happened. 638 

 639 

Delipidation ● Timing 7-50 d 640 

6. At room temperature, under the fume hood, if perfusion applicable, continue with 641 

same pump perfusion system, if not applicable, continue with the passive incubation 642 

on the shaker.  643 

? TROUBLESHOOTING 644 

i. PBS wash twice in 1 day. 645 

ii. Dehydrate with 50% EtOH/H2O solution for 1-7 days.  646 

iii. Dehydrate with 70% EtOH/H2O solution for 1-7 days.  647 

iv. Dehydrate with 100% EtOH solution for 1-7 days.  648 

v. Dehydrate with 100% EtOH solution for 1-7 days, until the organ does not 649 

shrink anymore.  650 

vi. Delipidate with DCM/MeOH (2:1, v/v) solution for 1-7 days, refresh the 651 

solution 2-3 times. 652 

vii. Rehydrate with 100% EtOH solution for 1-7 days. 653 

viii. Rehydrate with 70% EtOH/H2O solution for 1-7 days. 654 

ix. Rehydrate with 50% EtOH/H2O solution for 1-7 days. 655 

x. Rehydrate with diH2O for 1-7 days. 656 

!CAUTION The glass chamber should be covered with plastic wrap and aluminium 657 

foil to avoid the evaporation of solution and light illumination under fume hood. EtOH, 658 

MeOH or DCM is highly volatile liquid, especially under the fume hood. The chamber 659 

should be carefully sealed with several layers of plastic wrap and tapes to prevent the 660 

volatility of solutions. Replenish the desired solutions to cover the whole sample if 661 

needed during the circulation. DCM could erode some types of tubing (e.g. 662 

polystyrene), therefore the recommended tubing is from PTFE 663 

(polytetrafluoroethylene) or PP (polypropylene). Displace the reference tubing every 2 664 

days.  665 

 666 

ECM loosen ● Timing 2-15 d 667 

7. At room temperature, under the fume hood, if perfusion applicable, continue same 668 

pump perfusion system, if not applicable, continue with the passive incubation on the 669 

shaker.  670 

? TROUBLESHOOTING 671 

i. Collagen hydrolysis with acetic acid solution for 1-7 days. 672 

ii. DiH2O wash twice in 1 day.  673 

iii. Glycoprotein extraction with guanidine solution for 1-7 days.  674 

!CAUTION The glass chamber should be covered with plastic wrap and aluminium 675 

foil to avoid the evaporation of solution and light illumination under fume hood. 676 

 677 

Labelling (optional) ● Timing 7-15 d 678 

If perfusion is applicable, continue same pump perfusion system, if not applicable, continue 679 

with the passive incubation on the shaker. The whole organ can be stained with cell nuclei 680 

dye of PI or TO-PRO-3 solution in PBS (1:1000 dilution) at room temperature for 2-7 days, 681 

the solution should cover the whole organ.  682 

 683 
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If antibody staining is needed, the organ of interest should be tested for certain antibody in 684 

sections first (validated antibody list in Table 2, and non-compatible antibody list in 685 

Supplementary Table 1). !CAUTION Antibody is macromolecule, if perfusion is not 686 

applicable, big organs should be dissected into no more than 1.5 cm thick sections to reach 687 

antibody full penetration. Actively pumped antibody solutions to stain intact human organ 688 

have not yet been tested, while Nanobodies have been proven to stain intact pig organs in 689 

active pumping set up. 690 

8. Sample preparation for antibody/dye/nanobody screening: parts of the targeted tissue 691 

could be sliced to 40 µm thin sections on glass slides by Cryostat following the 692 

standard protocol or cut into 0.3-1 mm floating slices by vibratome following standard 693 

protocol. These sections on glass or floating slices could be used for antibody 694 

screening.  695 

9. SHANEL pre-treatment for antibody screening: At room temperature, treat the floating 696 

slices with CHAPS/NMEDA solution twice per 12 hours. Wash three times with PBS 697 

for 20 min each. Gradually dehydrate in 50%, 70% and 100% EtOH/H2O, 2 hours per 698 

step. Change to DCM/MeOH (2:1, v/v) solution overnight. Rehydrate in 100%, 70%, 699 

50% EtOH/H2O and diH2O, 2 hours per step. Treat with acetic acid solution overnight, 700 

wash twice for 20 min in diH2O, treat with guanidine solution for 6 hours and wash 701 

twice for 20 min in diH2O. 702 

10. These floating slices are blocked with blocking buffer at 37 °C for overnight, then 703 

incubated with commercialized antibodies in antibody incubation buffer at 37 °C for 2 704 

days.  705 

11. The concentration of antibody should be tested according to the manufactures’ 706 

suggestions. If needed, repeat the incubation with proper secondary antibody at 37 707 

°C for 2 days. The samples are washed with washing buffer three times for 1 hour at 708 

room temperature.  709 

12. Gradually dehydrate in 50%, 70% and 100% EtOH/H2O, 2 hours per step. Change to 710 

DCM for 1 hour and then change to BABB until the slice get transparent. 711 

13. Lastly, the results are examined with confocal microscope to find the best conditions 712 

for strong and specific antibody staining.  713 

▲CRITICAL We strongly suggest using Alexa dye or Atto dye as conjugated 714 

fluorophores of antibody, which is stable and bright in clearing solution.  715 

14. After getting the optimistic staining results from antibody screening, dissect the region 716 

of interest from the human organ and treat the tissue slice or block following the 717 

timing in Table 4.  718 

! OPTIONAL Autofluoresecnt lipofusin accumulated in aged human sample, incubate 719 

the slice with CuSO4 solution for 1-7 days before clearing to eliminate tissue 720 

autofluorescence. 721 

? TROUBLESHOOTING 722 

 723 

Clearing ● Timing 7-40 d 724 

15. At room temperature, under the fume hood, if perfusion applicable, continue same 725 

pump perfusion system, if not applicable, continue with the passive incubation on the 726 

shaker. ? TROUBLESHOOTING 727 

i. PBS wash twice.  728 

ii. Dehydrate with 50% EtOH/H2O solution for 1-7 days.  729 

iii. Dehydrate with 70% EtOH/H2O solution for 1-7 days.  730 

iv. Dehydrate with 100% EtOH solution for 1-7 days.  731 
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v. Dehydrate with 100% EtOH solution for 1-7 days, until the organ does not 732 

shrink anymore.  733 

vi. Delipidate with DCM solution for 1-7 days, until the sample sink to bottom. 734 

vii. RI matching with BABB solution for 1-30 days until the organ get completely 735 

transparent.   736 

!CAUTION The glass chamber should be covered with plastic wrap and aluminium foil to 737 

avoid the evaporation of solution and light illumination under fume hood. EtOH or DCM is 738 

highly volatile liquid, especially under the fume hood. The chamber should be carefully 739 

sealed with several layers of plastic wrap and tapes to prevent the volatility of solutions. 740 

Replenish the desired solutions to cover the whole sample if needed during the circulation. 741 

DCM could erode some types of tubing (e.g. polystyrene), accordingly, the recommended 742 

tubing is from PTFE (polytetrafluoroethylene) or PP (polypropylene). Displace the reference 743 

tubing every 2 days (Supplementary Video 1). 744 

■ PAUSE POINT The cleared human organs in BABB solution could be stored at room 745 

temperature and covered with aluminium foil for months to years before imaging. 746 

 747 

Imaging with light-sheet fluorescent microscopy ● Timing 1-8 d 748 

16. Here we use the prototype light-sheet microscope from Miltenyi Biotec to image the 749 

human pancreas (Fig. 3). The commercialized UltraMicroscope Blaze can also be 750 

applied for high resolution imaging of large human organs, they are controlled by the 751 

same software named “Imspector”. 752 

i. Check the sample in BABB solution if there are bubbles inside of organs. If 753 

yes, carefully suck out the bubbles using 1 ml syringe. (Supplementary Video 754 

2) 755 

ii. On pieces of tissue paper, prepare the clean sample holder, glue, tape and 756 

samples, for example, human pancreas. 757 

iii. Cut three pieces of tape and stick on the top, middle, bottom parts of sample 758 

holder. 759 

iv. Add the glue on the tapes of sample holder. To stick the sample durable, the 760 

glue is covering full area of the tapes. !CAUTION If the glue is not sufficient, 761 

the sample is not stable on the holder and would shift or fall down during the 762 

2-3 days of scanning.  763 

v. Use tissue paper to absorb BABB solution from one side of sample several 764 

times. 765 

vi. The glue would contact the dry side of sample. Carefully put the sample on 766 

the sample holder and try to keep the centre of sample aligning with the 767 

holder. One end of sample should be close to one end of the moving range of 768 

holder (e.g. top to top).  769 

vii. Waiting for 30-60 seconds until the glue is getting solid.  770 

viii. Put the sample holder back to the light-sheet microscope and fix it. 771 

ix. Check again the sample in BABB solution of chamber if there are bubbles 772 

inside of organs. If yes, carefully suck out the bubbles using 1 ml syringe. 773 

!CAUTION Gently touch the sample when sucking out bubbles, otherwise, the 774 

glue bonding would be destroyed mechanically and the sample would shift or 775 

fall down.  776 

17. Setting imaging parameters in Imspector software. (Supplementary Fig. 3) 777 

i. Go to “Settings” → “Hardware” → “Ultra3 Settings” → “Objective” to choose 778 

the right objective, for example “LVBT 1x”.  779 
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ii. Start the View-settings of software with:  780 

iii. “Measurement Mode” to be “Multi Color Mosaic Acquisition”; 781 

“Devices 1” to be “Ultra3 filter”; 782 

“Devices 2” to be “xyz-Table Z”; 783 

“Devices 3” to be “xyz-Table X”; 784 

“Devices 4” to be “xyz-Table Y”; 785 

“AS” means autosave, to be “abled” in green; 786 

“Split” to be “abled for Devices 1”; 787 

“Channel Setup” to click the targeted scanning channels according to the 788 

labelling, “Excitation 561, Emission 595/40” and “Excitation 785, Emission 789 

empty” here; 790 

“Sheet NA” to be “0.035”, means “Thickness” to be “21 µm”; 791 

“Sheet Width” to be “100%”; 792 

“Zoom” to be “1.0x”; 793 

“Measurement → Liquid” to be “BABB”;  794 

“Measurement → Mount” to be “None”;  795 

“Exposure Time” to be “90.000-100.000”; 796 

“Gain” to be “16-bit low noise”; 797 

“Step” means the step size in um between each two images in Z axis, for 798 

example, “-8.00” is set for human pancreas;  799 

!CAUTION The smaller the step size, the more number of images will be 800 

acquired, and the scanning will take longer, but the resolution in XZ and YZ 801 

direction will increase.    802 

iv. “LightSheet Selection” to be only “left” or only “right” when checking the signal 803 

and position of sample.  804 

v. With one side of laser running, adjust the sample stage in Z direction till the 805 

laser only illuminates close to top surface of sample as starting position of 806 

scanning. (Supplementary Video 3).  807 

!CAUTION Avoid collision of moving objective with the sample in finding focus 808 

step, and the sample should only be illuminated on the surface in the starting 809 

position step. 810 

vi. Mount the 1.1x objective and then click the “Focus → down” button in the 811 

software until the lens get immersed in BABB solution of chamber, adjust the 812 

movement of the objective and gets a clear and bright signal place as focus. 813 

Then lower the sample holder until the sample is just lower than the light sheet 814 

illumination region, click “Current Position → “Set as Zero” and “Scan Range 815 

→ Start” to be “0.000”.   816 

? TROUBLESHOOTING 817 

vii. Next lifting up the sample holder, the signal gets blurry when imaging plane 818 

gets deeper in the sample. Then Click “Scan Range → End”. Since the light 819 

sheet microscopy 1.1x objective working distance is around 17mm in z 820 

direction, the maximum imaging depth would be -14 mm.  821 

viii. Adjust “Mosaic → Set Parameters” to find the proper “X Axis, Y Axis” and 822 

“Overlap” to cover the scanning volume of samples from edges. In general, for 823 

1.1x objective, “3x8” with 30% overlapping or “4x7” with 33% overlapping 824 

would cover the human pancreas or human kidney. For 12x objective, “10x10” 825 

with 30-40% overlapping is possible. !CAUTION Following image stitching will 826 

be less accurate if overlapping value is set too small. When setting the 827 
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scanning volume, do NOT touch the travelling limitations of stage in X or Y 828 

direction, do NOT touch the objective in Z direction. Otherwise, the software 829 

would report error and fail.  830 

ix. Choose “Autosave Settings” to fill in the “path” and “name” for saving, such as 831 

“humanpancreas_1x_4x7_33o_90ex_8um_56130_78540_forwardup”; 832 

x. Stop the live “View”, and Click the “Lightsheet Selection” to be “both”; 833 

xi. Start the scanning and keep the room in dark for around 2-3 days. 834 

xii. When the scanning finished, take the sample holder out and cut the tapes to 835 

remove the sample from holder. Put the sample in BABB solution and pill off 836 

the glue and tape at the same time. Wash the sample holder with 100% EtOH 837 

and clean with tissue paper.  838 

xiii. Repeat i-xix, change the position of the sample or flip the sample in step vi to 839 

make sure the scanning covers both ends and both sides of sample. For 840 

example, human pancreas took four times of scanning to finishing the whole 841 

organ imaging covering forward-up, forward-down, backward-up, backward-842 

down. 843 

 844 

 Data stitching, renaming and compression ● Timing 1-2 d 845 

18. When the first round of scanning is finished, TIFF files are generated from light-sheet 846 

microscope in the autosave folder. Create new folders inside this autosave folder with 847 

names of C00, C01… for the stitched images, corresponding to the image channels. 848 

i. Open Fiji, click “Plugins” → “Stitching” → “deprecated” → “Stitch Sequence of 849 

Grids of Images”. 850 

ii. Correct the “Stitch Image Grid Sequence” with the right information from the 851 

scans in terms of “grid size x”, “grid size y”, “grid size z”, “overlap”, “Input 852 

directory”, “file names”, “Output directory”, “start x”, “start y”, “start z”, “start i”, 853 

and the other settings are accepted as default. 854 

“grid size x” to be the number of “X Axis” in light-sheet microscope scanning.  855 

“grid size y” to be the number of “Y Axis” in light-sheet microscope scanning.  856 

“grid size z” to be “1”. 857 

“overlap” to be the number of “Overlap” in light-sheet microscope scanning.   858 

“Input directory” to be the path of the autosave folder. 859 

“file names”: copy the name of first .tif image from the autosave folder to here 860 

and replace Ultra3[00 x 00] to be Ultra3[{yy} x {xx}], Z0000 to be Z{zzzz}.  861 

“Output directory” to be the path of “C00” folder inside the autosave folder. 862 

“Start x” to be “0”.  863 

“Start y” to be “0”. 864 

“Start z” to be “any number small than the total number of images”, in general, 865 

we choose a number in the middle.  866 

“Start i” to be “1”. 867 

iii. Click “OK” and wait for the running of stitching. 868 

iv. Open the new stitched image (Number is the setting in “Start z”.) in folder 869 

“C00” with Fiji to check if the image quality is OK.  ! OPTIONAL Other 870 

alternative algorithms are recommended, for example, TeraStitcher 871 

(https://abria.github.io/TeraStitcher/). 872 

? TROUBLESHOOTING 873 

https://abria.github.io/TeraStitcher/
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v. With the finishing of first stitching, a file called 874 

“TileConfiguration.text.registered” would be generated in the “Input folder”, 875 

which contains the stitching parameters and coordinates of tiles information. 876 

vi. Rename this file to delete the “.registered” part and to generate a .txt file, 877 

“TileConfiguration_(zzz)(2)”. 878 

vii. Copy this file into folder “C00” and open it, the “C00_xyz-Table Zxxxx” shows 879 

the number as set in the step xiv “Start z”. Revise the “Zxxxx” to “Z0000” in all 880 

tiles. 881 

viii. Copy this new “TileConfiguration_(zzz)(2)” file to other channel folders and 882 

revise the “C00_xyz-Table” in all tiles to responding channel number, for 883 

example, “C00” to “C01” in folder “C01”; “C00” to “C02” in folder “C02”. Each 884 

channel requires its own “TileConfiguration_(zzz)(2)” file with corresponding 885 

channel number and saved in the respective folder. 886 

ix. Open the file “Stitching.py” with Fiji, which would run the 887 

“TileConfiguration_(zzz)(2)” file to finish all stitching. 888 

x. Click “run”, and load the “TileConfiguration_(zzz)(2)” file, fill in the total 889 

numbers of scanning images. 890 

xi. Repeat vii-viii for each “TileConfiguration_(zzz)(2)” file in each channel folder. 891 

xii. All stitched images would be separately saved in corresponding channel 892 

folders, “C00”, “C01”… 893 

xiii. Since the stitched tiff images are named with sequential numbers in each 894 

channel folder, we would use “Total Commander” software to rename each of 895 

the images. Run the software, on the left panel, open the file of stitched folder 896 

“C00”, choose all “Manual_StitchedZxxxx” images, “Files” → “Multi-Rename 897 

Tool” . 898 

“file name” to be “C00_Z”. Then click “[C] Counter”. 899 

“Define counter [C]” to be “Start at 0”, “Step by 1” and “Digits 4”. 900 

Click “Start!” button and the software would rename all 901 

“Manual_StitchedZxxxx” images in folder C00 to be “C00_Zxxxx”. 902 

xiv. Repeat xiii for other channel folders, for example, “C01” to rename the 903 

“Manual_StitchedZxxxx” images in folder C01 to be “C01_Zxxxx”. 904 

xv. Transfer all stitched images from different channel folders into one folder, for 905 

example, “C00”. 906 

xvi. Run “LZW compression” using software “ImageMagick” to compress all 907 

stitched images in folder “C00”. 908 

xvii. Repeat i-xvi for all different volumetric light-sheet microscopy scans. For 909 

example, human pancreas would generate four stitched image folders from 910 

four times of scanning. 911 

 912 

 Arivis fusion ● Timing 1-6 d 913 

19. Use “Arivis Vision 4D” to merge multiple 3D volumes. 914 

i. Open “Arivis SIS Converter” → “Add Files” to load all of the stitched images 915 

from different channels in C00 folder. If “Assume same structure for all files?” 916 

shows up, click “Yes”. 917 

ii. “Import Files” → “Custom import” →  “Browse” to choose the output folder, → 918 

“File Name” to define the name of Arivis file, for example, “Human 919 

pancreas_forward up.sis”. ▲CRITICAL All stitched images from different 920 

channels must be in the same folder.  921 
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iii. “more options” → “Target Pixel Type” → “16-Bit integer”. 922 

iv. Click “OK” → “Manual import mapper” → “Selection” → “Pattern matching” → 923 

“OK” to load the right information of images about channels and image planes. 924 

v. “Start” to convert all stitched images from different channels into Arivis file. 925 

!CAUTION The .sis Arivis file could be several Terabytes after fusion, for 926 

example, human pancreas has 2.5 Terabytes. It is important to save the .sis 927 

files in the local drive with enough capacity. The running of Arivis could fail 928 

due to poor connection to network drive.  929 

vi. Repeat i-iv to convert all volumetric scans of sample, for example, human 930 

pancreas has four Arivis files, corresponding to forward-up, forward-down, 931 

backward-up, backward-down. 932 

vii. Double click the first .sis file to open the Arivis Vision 4D. 933 

viii. “Data” → “Pixel Size” to revise the X, Y, Z number to be the correct size from 934 

the light-sheet microscopy scanning settings. For example, 1.1x objective has 935 

the pixel size of 6.5/1.1=5.909 µm in X and Y; 4x objective has the pixel size 936 

of 6.5/4=1.625 µm in X and Y; 12x objective has the pixel size of 6.5/12=0.542 937 

µm in X and Y. The Z pixel size is the “Step size” parameter. Click “Change 938 

Pixel Size”. “Save” the file. 939 

ix. Click the “i” button on the left corner to check the image information with 940 

“Image Set” and “Plane”, which should be “16 bit” and “number of total 941 

images”. 942 

x. To load the second volumetric scans, “File” → “Import” to choose the second 943 

.sis file, → “Import Files” → “more options” → “Import as New Image set” → 944 

“Target Pixel Type” to be “16 Bit integer”. ▲CRITICAL The pixel type should 945 

be matched for all loaded volumetric files. 946 

xi. When the second .sis file loading finishes, revise the pixel size following step 947 

vii again and save the file. 948 

xii. Click the button on the right corner of presenting as “Vertical Split”. “Navigator” 949 

→ “Images Set” to show the two volumetric scans separately (one is default 950 

file), scroll the 2D images to zoom in and out for better view of data, adjust the 951 

color bar of each channel for the brightness and contrast. 952 

xiii. If the two volumetric scans are from different side of sample scanning, “Data” 953 

→ “Transformation Gallery” → “Available Transformations” → “Flipping” → 954 

“Flipping Properties” → “Flip X-Axis” or “Flip Y-Axis” or “Flip Z-Axis” to match 955 

the X, Y, Z orientations of both volumes. Click “OK” to run it. “Save” the file 956 

again after finishing.  957 

xiv. A new image set would show up in the “Image Set”, open the “default” and 958 

“flipped” files with same orientations. 959 

xv. In the overlapping volume, identify at least three landmarks in both of the two 960 

image sets by zooming in or out and adjusting the planes. ▲CRITICAL The 961 

landmarks could be the same cell, the same hole, the same vessel structure 962 

or the same junctions. The landmarks should cover the overlapping volume as 963 

much as possible. For example, the first landmark is labeled from the top-right 964 

area in the beginning of Z plane, the second landmark is labeled from the 965 

middle-left area in the middle of Z plane and the third landmark is labeled from 966 

the bottom-right area in the last of Z plane. So the three landmarks could form 967 

triangles in any of the XY, YZ and XZ planes. If possible, identify more 968 
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landmarks in each of these areas in case wrong labels happen due to the 969 

different scanning angle from the light-sheet. 970 

xvi. Click the icon “Place New Object” → “Marker” to label the same landmarks in 971 

both image sets and colorful squares would show up. Click “Show Objects 972 

Table” to view the information of markers. 973 

xvii. Click “Data” → “Volume Fusion” → “Image Sets” to choose the right “Base 974 

Image Set” and “Moving Image Set”, “Save as” choose “New File”, “Image Set 975 

Name” to define the name for new fusion. “Transformation” → “landmark 976 

Registration” → “Base Image Set” → “ Add All Objects as Landmarks” by right 977 

clicking the set icon. Do the same for “Moving Image Set”. Right click marker 978 

to delete the unwanted ones. In the end, three same landmarks are enough. 979 

“Scale” to be “10%”. Click “Run” to finish the trials of fast volume fusion for 980 

preview. ▲CRITICAL The sequence of landmarks should be the same in both 981 

image sets. The highlighted locations of landmarks would display in the right 982 

window.  983 

xviii. If the new fusion is not good, for example, with mismatching, gap or ghosting, 984 

try different combinations of three different landmarks to get the best fusion 985 

quality in both 2D view and 3D view. 986 

xix. If fusion is good enough, change the “Scale” to be “100%” and run the final 987 

fusion to generate the new .sis file with both volume sets. 988 

xx. Click “Show Objects Table” to view the information of markers, → “Im/Export” 989 

→ “Excel Export” → “Save As” to choose the folder, → “Export” to keep the 990 

record of landmarks for both image sets. 991 

xxi. Repeat step vi-xix to fuse each of other parts of volumetric scan into the new 992 

fused file. For example, repeat three times of the process to generate the final 993 

3D fusion .sis file for human pancreas. 994 

xxii. “File” → “Export” → “TIFF Exporter” and define the file name in a new folder to 995 

generate a series of .tif images. All final fused images from all channels would 996 

be saved in the folder. 997 

xxiii. Run “Total Commander” software to rename each of the images. Run the 998 

software, on the left panel, open the files in the saved folder, “Mark” → “Select 999 

Group” → input “C00” → “OK” to choose all files containing the “C00”. 1000 

xxiv. “Files” → “Multi-Rename Tool” → “file name” to be “C00_Z”, Click “[C] 1001 

Counter”, “Define counter [C]” to be “Start at 0”, “Step by 1” and “Digits 4”. 1002 

Click “Start!” button and the software would rename all images with “C00” in 1003 

the saved folder to be “C00_Zxxxx”. 1004 

xxv. Repeat xxii-xxiii to rename the fused images for other channels. 1005 

xxvi. Run “LZW TIFF 16bit” to compress all fused images in the saved folder. 1006 

? TROUBLESHOOTING 1007 

 Imaris 3D visualization ● Timing ~0.5-2 d 1008 

20. Here we only include the basic and simple steps for Imaris 3D visualization. For more 1009 

functional analysis, please check the Imaris website for user guide. 1010 

i. Open “Imaris File Converter” → “Add Files” to load all of the fused images in 1011 

the saved folder. Define the save path in “Output”.  1012 

ii. Click on the loaded files → “Settings” → Select “File names with delimiter”, 1013 

confirm the format as C“C”_Z“Z”.tif. Then click “Start All”. 1014 

iii. Following the save path, an “Imaris Image File” is generated. 1015 
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iv. Double click to open the Imaris file, “Edit” → “Image Properties” → 1016 

“Geomertry” → “Voxel Size”. X=6.5/objective, Y=6.5/objective, Z= “z” step size 1017 

in the imaging setting. For example, if choosing the 1x Objective with a z step 1018 

of 8 µm, then X=6.5 µm, Y=6.5 µm, Z=8 µm. if choosing the 12x Objective 1019 

with a z step of 6 µm, then X=0.542 µm, Y=0.542 µm, Z= 6 µm. 1020 

v. “Edit” → “Show Display Adjustment” to change the channel colors and adjust 1021 

the contrast. 1022 

vi. “Imaging Processing” → “Camera Function” → “Set The Angle Of The 1023 

Camera” to set needed 3D views.  1024 

vii. “Snapshot” → “Preferences” → “Snapshot” to set the Size, DPI (at least 300), 1025 

Save as Type (TIFF images), Image Output Directory. 1026 

 1027 

Timing 1028 

See Table 4. 1029 

 1030 

Troubleshooting 1031 

See Table 5. 1032 

 1033 

Anticipated Results 1034 

We described SHANEL in the presented protocol as a scalable tissue labelling and clearing 1035 

method for a variety of human organs (Supplementary Video 4), including pancreas (Figs. 3-1036 

5), kidney, and additional vessel labelling of spleen, heart and lung compared to our original 1037 

publication (Fig. 5), we also extend the original method to be compatible with human hard 1038 

tissue with bone (Fig. 7). SHANEL allows imaging of intact human organs at cellular 1039 

resolution, which paves the way for human organ mapping, and potentially extends our 1040 

knowledge in human organ anatomy. The technique can be used to study vascular 1041 

morphology and pathology, as the fine details of capillary can be visualized throughout whole 1042 

organ (Fig. 5). 1043 

 1044 

We previously used SHANEL to label and quantify the pancreas islets in INS-EGFP 1045 

transgenic pig20, demonstrating the scalability of this method to study large scale biological 1046 

samples. SHANEL is also applicable for antibody staining in human tissue or biopsies (Fig. 1047 

6), increasing its adaptability in biomedical research. 1048 

 1049 

After using the recently developed LSFM to image the transparent human organs or tissues 1050 

and to therefore acquire spatial information of vessels and fluorescent protein signal (Fig. 3, 1051 

Supplementary Fig. 3), the whole data set can be efficiently stitched with an easily operated 1052 

software (Supplementary Fig. 4). Here, we show an example of how raw images were 1053 

processed and visualization for the entire 3D fields and cellular states information was rapidly 1054 

achieved in a simple-to-use software (Supplementary Fig. 5-6). Note that, due to the size of 1055 

human organs, terabytes of the image data will be generated. Consequently, it would be 1056 

suggested to combine our methodology with deep learning approaches to achieve accuracy 1057 

and speed in quantification and further analysis. We summarize a workflow (Supplementary 1058 

Fig. 7) that will be useful for researchers in order to select critical steps and apply this 1059 

protocol.  1060 

 1061 

Acknowledgement 1062 



 
 

24 

We thank Alireza Ghasemi Mag for developing the python script “Stitching.py” to stitch 1063 

sequences of images. We thank Izabela Horvath for revising the manuscript. We thank 1064 

Miltenyi Biotec for providing the PE-conjugated antibodies. Schematic of SHANEL pipeline is 1065 

created with BioRender.com. This work was supported by the Vascular Dementia Research 1066 

Foundation, Deutsche Forschungsgemeinschaft (DFG, German Research Foundation) under 1067 

Germany’s Excellence Strategy within the framework of the Munich Cluster for Systems 1068 

Neurology (EXC 2145 SyNergy, ID 390857198), H.M. and Z.R. would like to thank the China 1069 

Scholarship Council (CSC) for the financial support (No. 201806780034 and No. 1070 

201806310110). 1071 

 1072 

Author Contributions 1073 

A.E. conceived and led the project. S.Z. developed the original SHANEL protocol. H.M., Z.R. 1074 

and S.Z. performed the experiments and wrote the manuscript. R.C. performed the antibody 1075 

screening. H.S. and I.B. dissected and provided the human organs. All authors commented 1076 

on the manuscript text. 1077 

 1078 

Data availability 1079 

The raw data that support the findings of this study are available from the corresponding 1080 

author upon reasonable request. 1081 

 1082 

Competing interests 1083 

A.E. and S.Z. filed a patent on SHANEL technologies described in this study. 1084 

 1085 

Additional information 1086 

Supplementary information is available at http://discotechnologies.org/SHANEL/. 1087 

 1088 

References 1089 

 1090 

 1091 

1 Snyder, M. P. et al. The human body at cellular resolution: the NIH Human Biomolecular Atlas 1092 
Program. Nature 574, 187-192, doi:10.1038/s41586-019-1629-x (2019). 1093 

2 Rood, J. E. et al. Toward a Common Coordinate Framework for the Human Body. Cell 179, 1094 
1455-1467, doi:10.1016/j.cell.2019.11.019 (2019). 1095 

3 Rozenblatt-Rosen, O., Stubbington, M. J. T., Regev, A. & Teichmann, S. A. The Human Cell 1096 
Atlas: from vision to reality. Nature 550, 451-453, doi:10.1038/550451a (2017). 1097 

4 Srivastava, S., Ghosh, S., Kagan, J. & Mazurchuk, R. The PreCancer Atlas (PCA). Trends Cancer 1098 
4, 513-514, doi:10.1016/j.trecan.2018.06.003 (2018). 1099 

5 Ardini-Poleske, M. E. et al. LungMAP: The Molecular Atlas of Lung Development Program. Am 1100 
J Physiol Lung Cell Mol Physiol 313, L733-L740, doi:10.1152/ajplung.00139.2017 (2017). 1101 

6 Amunts, K. et al. BigBrain: an ultrahigh-resolution 3D human brain model. Science 340, 1472-1102 
1475, doi:10.1126/science.1235381 (2013). 1103 

7 Deverman, B. E. et al. Cre-dependent selection yields AAV variants for widespread gene 1104 
transfer to the adult brain. Nat Biotechnol 34, 204-209, doi:10.1038/nbt.3440 (2016). 1105 

8 Erturk, A. et al. Three-dimensional imaging of solvent-cleared organs using 3DISCO. Nat 1106 
Protoc 7, 1983-1995, doi:10.1038/nprot.2012.119 (2012). 1107 

http://discotechnologies.org/SHANEL/


 
 

25 

9 Cai, R. et al. Panoptic imaging of transparent mice reveals whole-body neuronal projections 1108 
and skull-meninges connections. Nat Neurosci 22, 317-327, doi:10.1038/s41593-018-0301-3 1109 
(2019). 1110 

10 Pan, C. et al. Shrinkage-mediated imaging of entire organs and organisms using uDISCO. Nat 1111 
Methods 13, 859-867, doi:10.1038/nmeth.3964 (2016). 1112 

11 Park, Y. G. et al. Protection of tissue physicochemical properties using polyfunctional 1113 
crosslinkers. Nat Biotechnol, doi:10.1038/nbt.4281 (2018). 1114 

12 Renier, N. et al. Mapping of Brain Activity by Automated Volume Analysis of Immediate Early 1115 
Genes. Cell 165, 1789-1802, doi:10.1016/j.cell.2016.05.007 (2016). 1116 

13 Belle, M. et al. Tridimensional Visualization and Analysis of Early Human Development. Cell 1117 
169, 161-173 e112, doi:10.1016/j.cell.2017.03.008 (2017). 1118 

14 Pan, C. et al. Deep Learning Reveals Cancer Metastasis and Therapeutic Antibody Targeting in 1119 
the Entire Body. Cell 179, 1661-1676 e1619, doi:10.1016/j.cell.2019.11.013 (2019). 1120 

15 Kubota, S. I. et al. Whole-Body Profiling of Cancer Metastasis with Single-Cell Resolution. Cell 1121 
Rep 20, 236-250, doi:10.1016/j.celrep.2017.06.010 (2017). 1122 

16 Lai, H. M. et al. Next generation histology methods for three-dimensional imaging of fresh 1123 
and archival human brain tissues. Nat Commun 9, 1066, doi:10.1038/s41467-018-03359-w 1124 
(2018). 1125 

17 Morawski, M. et al. Developing 3D microscopy with CLARITY on human brain tissue: Towards 1126 
a tool for informing and validating MRI-based histology. Neuroimage 182, 417-428, 1127 
doi:10.1016/j.neuroimage.2017.11.060 (2018). 1128 

18 Hildebrand, S., Schueth, A., Herrler, A., Galuske, R. & Roebroeck, A. Scalable Labeling for 1129 
Cytoarchitectonic Characterization of Large Optically Cleared Human Neocortex Samples. Sci 1130 
Rep 9, 10880, doi:10.1038/s41598-019-47336-9 (2019). 1131 

19 Ku, T. et al. Elasticizing tissues for reversible shape transformation and accelerated molecular 1132 
labeling. Nat Methods 17, 609-613, doi:10.1038/s41592-020-0823-y (2020). 1133 

20 Zhao, S. et al. Cellular and Molecular Probing of Intact Human Organs. Cell 180, 796-812 1134 
e719, doi:10.1016/j.cell.2020.01.030 (2020). 1135 

21 Murakami, T. C. et al. A three-dimensional single-cell-resolution whole-brain atlas using 1136 
CUBIC-X expansion microscopy and tissue clearing. Nat Neurosci 21, 625-637, 1137 
doi:10.1038/s41593-018-0109-1 (2018). 1138 

22 Matsumoto, K. et al. Advanced CUBIC tissue clearing for whole-organ cell profiling. Nat 1139 
Protoc 14, 3506-3537, doi:10.1038/s41596-019-0240-9 (2019). 1140 

23 Susaki, E. A. et al. Whole-brain imaging with single-cell resolution using chemical cocktails 1141 
and computational analysis. Cell 157, 726-739, doi:10.1016/j.cell.2014.03.042 (2014). 1142 

24 Tainaka, K. et al. Whole-body imaging with single-cell resolution by tissue decolorization. Cell 1143 
159, 911-924, doi:10.1016/j.cell.2014.10.034 (2014). 1144 

25 Chung, K. et al. Structural and molecular interrogation of intact biological systems. Nature 1145 
497, 332-337, doi:10.1038/nature12107 (2013). 1146 

26 Ku, T. et al. Multiplexed and scalable super-resolution imaging of three-dimensional protein 1147 
localization in size-adjustable tissues. Nat Biotechnol 34, 973-981, doi:10.1038/nbt.3641 1148 
(2016). 1149 

27 Treweek, J. B. et al. Whole-body tissue stabilization and selective extractions via tissue-1150 
hydrogel hybrids for high-resolution intact circuit mapping and phenotyping. Nat Protoc 10, 1151 
1860-1896, doi:10.1038/nprot.2015.122 (2015). 1152 

28 Tainaka, K. et al. Chemical Landscape for Tissue Clearing Based on Hydrophilic Reagents. Cell 1153 
Rep 24, 2196-2210 e2199, doi:10.1016/j.celrep.2018.07.056 (2018). 1154 

29 Lai, H. M., Ng, W. L., Gentleman, S. M. & Wu, W. Chemical Probes for Visualizing Intact 1155 
Animal and Human Brain Tissue. Cell Chem Biol 24, 659-672, 1156 
doi:10.1016/j.chembiol.2017.05.015 (2017). 1157 



 
 

26 

30 Cequier-Sánchez, E., Rodríguez, C., Ravelo, A. G. & Zárate, R. Dichloromethane as a solvent 1158 
for lipid extraction and assessment of lipid classes and fatty acids from samples of different 1159 
natures. J Agric Food Chem 56, 4297-4303, doi:10.1021/jf073471e (2008). 1160 

31 Schmidt, M. M. D., R. C. P. ;  Mello, R. O. ;  Kubota, E. H. ;  Mazutti, M. A. ;  Kempka, A. P. ;  1161 
Demiate, I. M. Collagen extraction process. International Food Research Journal 23, 913-922 1162 
(2016). 1163 

32 Yanagishita, M., Podyma-Inoue, K. A. & Yokoyama, M. Extraction and separation of 1164 
proteoglycans. Glycoconj J 26, 953-959, doi:10.1007/s10719-008-9138-4 (2009). 1165 

33 Todorov, M. I. et al. Machine learning analysis of whole mouse brain vasculature. Nat 1166 
Methods 17, 442-449, doi:10.1038/s41592-020-0792-1 (2020). 1167 

34 Ugryumova, N., Matcher, S. J. & Attenburrow, D. P. Measurement of bone mineral density 1168 
via light scattering. Phys Med Biol 49, 469-483, doi:10.1088/0031-9155/49/3/009 (2004). 1169 

35 Greenbaum, A. et al. Bone CLARITY: Clearing, imaging, and computational analysis of 1170 
osteoprogenitors within intact bone marrow. Sci Transl Med 9, 1171 
doi:10.1126/scitranslmed.aah6518 (2017). 1172 

36 Grüneboom, A. et al. A network of trans-cortical capillaries as mainstay for blood circulation 1173 
in long bones. Nature Metabolism 1, 236-250, doi:10.1038/s42255-018-0016-5 (2019). 1174 

37 Gonzalez-Chavez, S. A., Pacheco-Tena, C., Macias-Vazquez, C. E. & Luevano-Flores, E. 1175 
Assessment of different decalcifying protocols on Osteopontin and Osteocalcin 1176 
immunostaining in whole bone specimens of arthritis rat model by confocal 1177 
immunofluorescence. Int J Clin Exp Pathol 6, 1972-1983 (2013). 1178 

38 Savi, F. M., Brierly, G. I., Baldwin, J., Theodoropoulos, C. & Woodruff, M. A. Comparison of 1179 
Different Decalcification Methods Using Rat Mandibles as a Model. J Histochem Cytochem 1180 
65, 705-722, doi:10.1369/0022155417733708 (2017). 1181 

39 Liu, A. K. et al. Bringing CLARITY to the human brain: visualization of Lewy pathology in three 1182 
dimensions. Neuropathol Appl Neurobiol 42, 573-587, doi:10.1111/nan.12293 (2016). 1183 

40 Murray, E. et al. Simple, Scalable Proteomic Imaging for High-Dimensional Profiling of Intact 1184 
Systems. Cell 163, 1500-1514, doi:10.1016/j.cell.2015.11.025 (2015). 1185 

41 Perbellini, F. et al. Free-of-Acrylamide SDS-based Tissue Clearing (FASTClear) for three 1186 
dimensional visualization of myocardial tissue. Sci Rep 7, 5188, doi:10.1038/s41598-017-1187 
05406-w (2017). 1188 

42 Nojima, S. et al. CUBIC pathology: three-dimensional imaging for pathological diagnosis. Sci 1189 
Rep 7, 9269, doi:10.1038/s41598-017-09117-0 (2017). 1190 

43 Jensen, K. H. & Berg, R. W. CLARITY-compatible lipophilic dyes for electrode marking and 1191 
neuronal tracing. Sci Rep 6, 32674, doi:10.1038/srep32674 (2016). 1192 

44 Mann, D. M., Yates, P. O. & Stamp, J. E. The relationship between lipofuscin pigment and 1193 
ageing in the human nervous system. J Neurol Sci 37, 83-93, doi:10.1016/0022-1194 
510x(78)90229-0 (1978). 1195 

45 Schnell, S. A., Staines, W. A. & Wessendorf, M. W. Reduction of lipofuscin-like 1196 
autofluorescence in fluorescently labeled tissue. J Histochem Cytochem 47, 719-730, 1197 
doi:10.1177/002215549904700601 (1999). 1198 

46 Neumann, M. & Gabel, D. Simple method for reduction of autofluorescence in fluorescence 1199 
microscopy. J Histochem Cytochem 50, 437-439, doi:10.1177/002215540205000315 (2002). 1200 

47 Yang, J. et al. Quenching autofluorescence in tissue immunofluorescence [version 1; peer 1201 
review: 2 approved with reservations, 1 not approved]. Wellcome Open Research 2, 1202 
doi:10.12688/wellcomeopenres.12251.1 (2017). 1203 

48 Helsby, M. A. et al. CiteAb: a searchable antibody database that ranks antibodies by the 1204 
number of times they have been cited. BMC Cell Biol 15, 6, doi:10.1186/1471-2121-15-6 1205 
(2014). 1206 

49 Voigt, F. F. et al. The mesoSPIM initiative: open-source light-sheet microscopes for imaging 1207 
cleared tissue. Nat Methods 16, 1105-1108, doi:10.1038/s41592-019-0554-0 (2019). 1208 



 
 

27 

 1209 

Figure Legends 1210 

Figure 1. Overview of SHANEL pipeline  1211 

SHANEL is composed of seven parts. After human organs and tissue are collected (Step 1), 1212 

human organs preparation is performed for removing blood and fixation(Step 2). The 1213 

continuous step is divided into active pumping (Step 3a) and passive incubation(Step 3b), 1214 

based on whether the organs are intact or not. Samples are then following permeabilization, 1215 

delipidation, ECM loosening, and chemical probes labelling. According to the antibodies 1216 

compatible with the SHANEL protocol, the organ of interest can be dissected into less than 1217 

1.5cm thick slices for immunolabelling (Step 4). Samples are then dehydrated, delipidated, 1218 

and matched for refractive index, until transparent (Step 5). Imaging of whole human organs 1219 

is performed in an UltraMicroscope Blaze LSFM, and tissue slices are captured with an 1220 

UltraMicroscope II LSFM for high resolution (Step 6). The data is stitched, volumes fused, 1221 

and rendered in 3D visualization (Step 7). 1222 

 1223 

Figure 2. Vessel labelling with dextran solution by active perfusion 1224 

(a) Photo of dissected human kidney with inserted tubing (scale bar: 1 cm). (b) The tubing 1225 

was changed to be PTFE (chemical-resistant, anti-adhesive, biocompatible) tube and tightly 1226 

fixed by double rope-fastening (red rectangle in c). (d) The inserted nozzle of PTFE tube was 1227 

cut with a slope angle to plug-in smoothly. (e) A set of connecting tubing contained the black 1228 

pump reference tube in the middle, two white tubes at both ends, tube connectors and a 1229 

pipette. The red arrows indicated the flow circulation direction. (f) Vessel labelling with 1230 

dextran solution using pump perfusion system (rotation of the wheel in g enables solution 1231 

flow into kidney, black pump reference tube was fastened by correct set up of cassette 1232 

shown in h). (i) Photos of human kidney after dextran labelling. (j) The dextran labeled 1233 

human kidney was sealed in a plastic bag.  1234 

 1235 

Figure 3. Organ mounting and imaging with light-sheet microscopy 1236 

(a) Photo of human pancreas before clearing (scale bar: 1 cm). (b) Photo of transparent 1237 

human pancreas after PI cell nuclei labelling and clearing, showing mesenteric artery (white 1238 

arrow) and lymph nodes (yellow asterisk) (scale bar: 1 cm). (c) The mounting of an organ on 1239 

a sample holder required glue and black tape. The red arrows show the moving range ends 1240 

of holder in Y direction. (d) The sample holder was gummed with four sections of tape and 1241 

dropped with glue. (e) One example of sample position with one end alignment to cover one 1242 

sample edge. (f) Another example of sample position with another end alignment to cover 1243 

the other sample edge. (g) The mounted human pancreas was illuminated by light sheet. 1244 

 1245 

Figure 4. 3D reconstruction of human pancreas 1246 

(a) 3D reconstruction of human pancreas imaged by light sheet fluorescence microscopy 1247 

focusing on the PI labeled cell nuclei (Green) and autofluorescence of 785 nm wavelength 1248 

(magenta) (scale bar: 1 cm). (b) Zoomed 3D reconstruction in figure A showed the vessels 1249 

and lymph nodes (red rectangular) (scale bars: 1 mm and 200um respectively). (c) 3D 1250 

reconstruction of one example of endocrine portion by high magnification of 12X objective 1251 

(scale bar: 200 um). (d) Diverse islets surrounded by acinar cells could be easily identified in 1252 

3D images of endocrine portion showing standard round or oval shape and irregular shapes 1253 

as well as variable sizes (red asterisk). Also, intralobular ducts could be located near the 1254 

islets (yellow arrow). (scale bars: 50 um, 50 um and 30um, respectively).  1255 
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Figure 5. SHANEL of human organs with perfusion of dextran vessel labelling dye  1257 

(a) Human heart after SHANEL protocol (i), 3D reconstruction (ii) shows blood vessels of 1258 

coronary artery (red) and myocardium which can be imaged in autofluorescence at 488 nm 1259 

(AF, green) (scale bars: 1 cm and 2mm, respectively).  (b) Human kidney after SHANEL (i), 1260 

structure of glomeruli can be seen in dextran labelled. TO-PRO3 labelled cell nucleus (scale 1261 

bars: 1 cm and 2mm, respectively). (c) One lobe of human lung was cleared and stained with 1262 

dextran, bronchus can be seen in AF (scale bars: 1 cm and 2mm, respectively).  (d) Image of 1263 

human pancreas and vasculature after SHANEL (scale bars: 1 cm and 2mm, respectively). 1264 

(e) Human spleen after SHANEL, fine structure of splenic artery was visualized in Imaris 1265 

(scale bars: 1 cm and 2mm, respectively).  1266 

 1267 

Figure 6. SHANEL of human tissues by passive incubation 1268 

(a) Skull labelled with lectin (yellow) and PI (blue) (i). XY section (ii) and magnified image (iii) 1269 

(scale bars: 1mm, 1mm and 100um, respectively). (b) brain slice labelled with Neurotrace 1270 

Nissl stain. (scale bars: 2mm and 300um, respectively). (c) brain tissue labelled with Iba1 1271 

antibody (i). YZ (ii) and XZ (iii) section, magnified image in XY section (iv) (scale bars: 1000 1272 

um, 700 um, 500 um and 40 um, respectively). (d) human lung tissue labelled with α-SMA 1273 

antibody (i). YZ (ii) and XZ (iii) section, magnified image in XY section (iv) (scale bars: 700 1274 

um, 500 um, 500 um and 150 um, respectively). 1275 

 1276 

Figure 7.  Passive incubation, clearing and 3D reconstruction of human pulvinar and 1277 

skull 1278 

(a) Photo of transparent human pulvinar after PI cell nuclei labelling and clearing by passive 1279 

incubation (scale bar: 1 cm). (b) 3D reconstruction of human pulvinar imaged by light-sheet 1280 

fluorescence microscopy focusing on autofluorescence (AF) of 488 nm wavelength (grey) 1281 

and PI labeled cell nuclei (Green) (scale bar: 1 cm). (c) section view of pulvinar showing the 1282 

connection between bone tissue and the pulvinar fibrofatty tissue (scale bar: 150 um). (d) 1283 

Human skull bone after PI cell nuclei labelling and clearing (scale bar: 1 cm).  (e) The human 1284 

skull imaged by light-sheet and confocal microscopy (Scale bar 500 um and 200 um, 1285 

respectively). 1286 

 1287 

Supplementary Figure 1. Human brain clearing by perfusion system 1288 

(a) The dissection of human brain with CL and CR (left and right carotids, respectively), VL 1289 

and VR (left and right veterbral arteries, respectively). (b) The human brain after dissection 1290 

and fixation. (c) The set up of human brain clearing by perfusion system under fume hood. 1291 

The human brain was put in a glass container and connected with input and output tubing 1292 

controlled by peristaltic pump. There were four channels to control the four connecting 1293 

tubings as indicated in C i. Two output tubings were connected with the carotids arteries as 1294 

shown in C ii and two output tubings were connected with the vertebral arteries as shown in 1295 

C iii. The input tubings were protected with gauze to avoid solid impurities entering and 1296 

blocking the tubings (see C iv). C v showed the decolorization effects of CHAPS/NMDEA 1297 

according to the blooming of dark green color from the organ. (d) The glass container was 1298 

sealed with several layers of plastic wrap to prevent the volatility of running solutions, 1299 

especially for EtOH, DCM, MeOH. (e) Photo of human brain after SHANEL pre-treatment 1300 

before clearing. Remaining blood in the vessels (b) was decolorized. 1301 

 1302 

Supplementary Figure 2. Passively stained conjugated antibody in centimeter-size 1303 

human kidney and lung tissue  1304 
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Collagen IV, catalase and cytokeratin 19 antibody staining (Green) in human kidney (a) and 1305 

lung (b). Top panel shows immunofluorescent staining images in confocal microscopy to 1306 

verify antibody compatibility with SHANEL. Bottom panel shows 3D reconstruction of tissue 1307 

with antibody labelling in Imaris. (scale bars: 20 um and 500 um, respectively) 1308 

 1309 

Supplementary Figure 3. Settings in imaging software 1310 

(a) The user interface of Lavision Imspector software. (i) refer to the setting of objective lens 1311 

and magnification. (ii) The names of the devices should be listed in the correct order. (iii) 1312 

One example for settings of the tiling scan with 4x7 tiles and 33% overlap. 1313 

 1314 

Supplementary Figure 4. Key steps for data stitching, renaming and compression 1315 

(a) One example for correcting information of ‘Stitching Image Grid Sequence’, and a1 1316 

highlighted the replacement of red letters in step x about ‘file names’. (b) The key information 1317 

of ‘TileConfiguration’ txt file, b1 highlighted the responding channel number should be 1318 

corrected and saved in respective separated folder and b2 highlighted the starting Z number 1319 

should be ‘0000’ for all ‘TileConfiguration’ files. (c) The information of ‘Stitching.py’. (d) One 1320 

example for settings of ‘Multi-Rename Tool’. (e) One example of compressing tiff files with 1321 

‘LZW TIFF’. 1322 

 1323 

Supplementary Figure 5. Key steps for Arivis fusion of 3D images 1324 

(a) One example of flipping one volumetric data of X or Y or Z direction to match with another 1325 

volumetric data. (b) The overview of two volumetric data showing same XYZ directions after 1326 

flipping. (c-d) Examples of identical structural markers from two volumetric data sets for 1327 

fusion. (e) Loading of three key markers for best fusion. (f) 3D fused image of pancreas from 1328 

two volumetric data sets. 1329 

 1330 

Supplementary Figure 6. Key steps for Imaris data loading and visualization 1331 

(a) One example of converting stitched image sequence data to the .ims format using Imaris 1332 

File Converter. (b) The settings for file names with delimiter should be changed into “C _ 1333 

Z.tif”. (c) 3D image properties including XYZ voxel size and channel color can be set in 1334 

Imaris for analysis. 1335 

 1336 

Supplementary Figure 7. Overview of SHANEL workflow  1337 

This workflow summarizes the main steps after organ collection: experimental setup (yellow), 1338 

pre-treatments (blue), labelling and clearing (grey) and imaging (red). We provided two ways 1339 

of handling samples: active perfusion with pump, if the vessels could be connected with 1340 

external tube, and passive incubation with shaker. Moreover, depending on the organ 1341 

components, organ size, targeted labelling, and imaging structurers, we outlined the 1342 

differences in the whole process. 1343 

  1344 
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Table 1| Challenges of human organ labelling, clearing and imaging 
1. Uncontrollable variables from human organ resources related to the pre-mortem 

state and post-mortem delay. 
Solution: Selecting reliable human organ and tissue donation organizations. 
 

2. Extremely complicated chemical compositions in terms of lipidome complexity, 
myelin density, lipofuscin accumulation and non-soluble, non-enzymatic collagen 
changes. 
Solution: An efficient detergent permeabilization is necessary to render the human 
tissue accessible to reagents traveling end-to-end through it. 
 

3. Residue blood clots due to the delay of post-mortem dissection. 
Solution: Setting up active perfusion system to deliver 0.01 M PBS/heparin before 
4% PFA fixation can reduce the blood remain in the vessel as much as possible. 
 

4. Strong autofluorescence at visible wavelengths (400-700 nm) from lipofuscin. 
Solution: chemical treatment (e.g. CuSO4, Sudan Black B, NaBH4) or 
photobleaching has been reported to reduce autofluorescence. We found that 
CuSO4 was greatly efficient in reducing the autofluorescence whilst being compatible 
with labelling. 
 

5. Advanced transgenic or virus tracing techniques for fluorescent labelling not being 
applicable for human organs. 
Solution: Selecting high binding specificities and affinities chemical probes or 
antibodies for human organs labelling. 
 

6. Increased costs of reagents and dyes due to the size of human organs. 
Solution: Using lower price N-methyldiethanolamine (NMDEA) and CHAPS mixture 
to achieve the permeabilization and decolorization.  
 

7. Volume of large-sized human organs exceeds the limit of volumetric imaging. 
Solution: Developing larger chamber size fully automated light-sheet microscopes 
to cover the range from entire mice to most human organs. 
 

8. Massive imaging data would be generated and need to be stored and analysed. 
Solution: Lempel-Ziv-Welch (LZW) TIFF compression and equip with network 
attached storage. 
 

 1345 
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Table 2| Dyes and antibodies compatible with SHANEL protocol 1348 

 Supplier Cat no. Dilution  
Hoechst Invitrogen H3570 1:1000  

PI Invitrogen P3566 1:1000  
TO-PRO-3 Invitrogen T3605 1:1000  

 Neuro trace Nissl Invitrogen N21483 1:1000  
DRAQ5 Thermo 62251 1:1000  
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Fisher 
Methoxy-X04 Tocris 4920 100 uM  

Dextran Sigma 52194 5 mg/ml  
Congo Red Sigma C6277 10 uM  

Lycopersicon 
Esculentum 

(Tomato) Lectin 

Vector DL1174 1:200  

Lycopersicon 
Esculentum 

(Tomato) Lectin 

Vector DL1178 1:200  

     
Antibodies Supplier Cat no. Dilution RRID 
Tyrosine 

Hydroxylase 
abcam ab112 1:200 AB_297840 

Ionized calcium 
binding adapter 
protein 1 (Iba1) 

Wako 019-19741 1:500 AB_839504 

Neuropeptide Y abcam ab30914 1:200 AB_1566510 
Myelin basic protein Atlas AMAb91064 1:200 AB_2665784 

Laminin Sigma L9393 1:200 AB_477163 
 Alpha-smooth 
muscle actin 

Sigma C6198 1:500 AB_1840528 

CD8 abcam ab237709 1:200 NA 
Angiotensin-

converting enzyme 
2 (ACE2) 

Invitrogen PA5-20039 1:200 AB_11154831 

     
Conjugated 
antibodies 

    

Atto647N-
conjugated anti-

GFP nanobooster 

Chromotek gba647n-
100 

1:1000 AB_2629215 

Collagen IV Miltenyi 130-122-866 1:100 AB_2857566 
Catalase Miltenyi 130-123-367 1:100 AB_2857591 

Cytokeratin 19 Miltenyi 130-125-272 1:100 AB_2857769 
     

Antibodies tested 
on mouse tissue 

Supplier Cat no. Dilution RRID 

Peripheral-Type 
Benzodiazepine 
Receptor 

abcam ab109497 1:500 AB_10862345 

Cleaved Caspase9 CST 9509 1:500 AB_2073476 
Caspase 9 abcam ab184786 1:500 NA 

Gama-H2AX Invitrogen 14-9865-82 1:500 AB_2573048 
 1349 
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 1351 

Table 3| Preparation of dextran working solution 1352 

 PMPI DTT Dextran PBS 
MW(g/mol) 214.2 154.2 500,000 - 

Stock concentration 20 mM 20 mM - - 
Stock solution DMSO PBS - - 
Weight (mg) 8.6 mg 15.4 mg 500 mg  

Volume of solution 2 ml 5 ml - 93 ml 
 1353 

 1354 
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Table 4 | Timing 1356 

Sample type Human 
Kidney 

Human 
Pancrea

s 

Human 
Spleen 

Human 
heart/lung 

Human 
Pulvinar 

Human 
Brain 

Human 
Skull 

Tissue 
slice/ 
block 

PBS wash 1d 1d 1d 1d 1d 2d 1d 1d 
Vessel labelling 1d 1d 1d 1d - - - - 

EDTA - - - - 7d-10d - 14-20d - 
CHAPS/NMDEA 10d-14d 5d-7d 5d-7d 10d-14d 5d-7d 20d 5d 3d 

PBS 1d 1d 1d 2d 1d 3d 1d 1d 
50% EtOH 1d 1d 1d 2d 1d 5d 1d 1d 
70% EtOH 2d 1d 1d 2d 1d 7d 1d 1d 
100% EtOH 2d 1d 1d 3d 1d 7d 1d 1d 
100% EtOH 2d+2d 1d 1d 3d 1d 7d 1d 1d 
DCM/MeOH 3d 2d 2d 3d 2d 7d 2d 2d 
100% EtOH 1d 1d 1d 2d 1d 4d 1d 1d 
70% EtOH 2d 1d 1d 2d 1d 5d 1d 1d 
50% EtOH 2d 1d 1d 2d 1d 5d 1d 1d 

DiH2O 1d 1d 1d 2d 1d 3d 8h 8h 
Acetic Acid 2d 1d 1d 2d 1d 7d 1d 1d 

DiH2O 8h 8h 8h 2d 8h 3d 8h 8h 
Guanidine HCl 1d 1d 1d 2d 1d 7d 1d 1d 

PBS 8h 8h 8h 2d 8h 3d 8h 1d 
Cell Nuclei Dye 7d 7d 7d 7d 7d - 2d - 

Antibody 
Labelling - - - - - - - 7-14d 

PBS 2d 1d 1d 2d 1d - 1d 1d 
50% EtOH 1d 1d 1d 2d 1d 5d 1d 1d 
70% EtOH 2d 1d 1d 2d 1d 7d 1d 1d 
100% EtOH 2d 1d 1d 2d 1d 7d 1d 1d 
100% EtOH 2d 1d 1d 3d 1d 7d 1d 1d 

DCM 3d 1d 1d 3d 1d 7d 1d 1d 
BABB 3d- 2d- 2d- 5d- 2d- 7d- 2d- 1d- 
Total 

processing time 
for each organ 

~54-60d ~36-38d ~36-38d ~69-73d ~43-48d ~135d ~43-49d ~32-39d 

 1357 

 1358 

 1359 



 
 

33 

Table 5 | Troubleshooting table 1360 

Step  Problem Possible reason Solution 
3 Undissolved  deposits 

in dextran vessel 
labelling solution 
 

Not sufficient mixture Prepare stock solution and 
mixture step by step 

 Difficult to find vessel Some organs have 
tube structure similar 
to vessel. For 
example, urine tract in 
kidney and trachea in 
lung 
  

Confirm the main arteries from 
anatomy text book, or ask experts 
for help 

 Organ cannot turn red 
after dextran injection 

Blockages in blood 
vessels  

Use higher pressure or a 50ml 
syringe to inject dextran solution 
 

4, 6, 
7, 14 

Solution leakage 
during active pumping 

Disconnection or 
breakage of tubing 

Change new tubing to continue 
pumping  

15 Poor organ shrinkage 
after clearing 

Insufficient incubation 
with ethanol 

Increase incubation time with 
ethanol  

17 The samples are not 
transparent enough 
and blurry under 
microscopy  

The samples are not 
dehydrated enough  

Make sure the organs  
dehydrated enough from the sign 
of no more shrinkage 
 

  The samples are not in 
sufficient time of BABB 

put the sample in BABB until 
transparent  

17 Shade inside the 
sample 

Not sufficient light 
sheet width  
 

Optimize sufficient light sheet 
width 

  Light absorption in 
surface by high-cell 
density region 

Try staining with a lower 
concentration of dye  

17 Vessel labelling only in 
some regions of the 
organs 

The vessel of organ is 
not intact 

Collect the organs carefully and 
try not to damage it 
 

  Residual blood clot in 
the sample  

Perfuse sample with sufficient 
PBS and Heparin before organ 
harvest  

17 Signal cannot be 
detected in the deeper 
tissue layer 

Short wavelength light 
cannot penetrate to the 
tissue due to scattering  

Use near infrared wavelength or 
longer wave length chemical 
probe or secondary antibodies.  

17 Staining worked only 
on the sample surface 

Incubation times were 
too short, or antibody 
incubation buffer 
volumes were too 
small.  

To process repeated staining, 
samples can be gradually 
rehydrated starting from Step 6 
Vii.  
 
Also increase incubation times 
and/or antibody incubation buffer 
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volume 
17 Sample are not visible 

during the imaging 
Out of focus Move the stage to find bright 

halos under objective and set up 
the right contrast on the computer 
screen.  

17 No positive signal, 
although the antibody 
works in IF on tissue 
sections  

Incompatibility with 
SHANEL protocol 

Check antibodies list or prototype 
with sections pre-treated with 
SHANEL protocol.  

17 Weak or non-
detectable antibody 
signals 

Insufficient antibody 
labelling or incapable 
antibody for SHANEL 
protocol 

Select the antibody form our 
verified antibody list or optimize 
the antibody staining conditions.  

17 High autofluorescence  Too long PFA fixation 
time 

Reduce PFA fixation time. Fix the 
sample in PFA less than four 
weeks. Change to PBS with 
sodium azide for long-term 
storage.  

18 Stitching failed with the 
tiling scans  

Sample has movement 
during imaging 

Use enough BABB resistant glue 
to fix the sample or use a custom 
made holder to fix the sample.  

18 Shade inside the 
sample  

Obstruction, such as 
bubbles 

Remove obstruction, such as 
using syringe to withdraw 
bubbles.  

18 Data are too large to 
analyze 

Unnecessarily high z-
resolution 
 
 
Unnecessarily high 
overlapping 
percentage of mosaic 

Optimize the Z steps based on 
the maximum possible z-
resolution of the lens.  
 
Optimize overlapping percentage 

19 Failed with the 
stitching grids of 
Images 

sample move during 
scanning 

Manual stitching or make sure the 
sample well fixed in the holder 
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 1363 

Supplementary table 1| Antibodies not compatible with SHANEL protocol 1364 

 1365 

Antibodies Supplier Cat no.
APC Calbiochem OP80100UG
GFAP  Sigma G3893
NeuN  Millipore MAB377
Calretinin abcam ab702
MMP13 abcam ab39012
myelin basic protein abcam ab7349
Parallbumin abcam ab11427
CD133/1 Miltenyi Biotec 130-115-292
Podoplanin Miltenyi Biotec 130-121-373
CD71 Miltenyi Biotec 130-124-358
CD90 Miltenyi Biotec 130-124-176
CD38 Miltenyi Biotec 130-123-347
JNK2 (MAPK9) Miltenyi Biotec 130-122-868
CD39 Miltenyi Biotec 130-125-078
WT1 Miltenyi Biotec 130-125-782
CD13 Miltenyi Biotec 130-125-787
CD272 (BTLA) Miltenyi Biotec 130-125-966



Figure 1. Overview of SHANEL pipeline 
SHANEL is composed of seven parts. After human organs and tissue are collected (Step 1), human 
organs preparation is performed for removing blood and fixation(Step 2). The continuous step is divided 
into active pumping (Step 3a) and passive incubation(Step 3b), based on whether the organs are intact or 
not. Samples are then following permeabilization, delipidation, ECM loosening, and chemical probes 
labelling. According to the antibodies compatible with the SHANEL protocol, the organ of interest can be 
dissected into less than 1.5cm thick slices for immunolabelling (Step 4). Samples are then dehydrated, 
delipidated, and matched for refractive index, until transparent (Step 5). Imaging of whole human organs 
is performed in an UltraMicroscope Blaze LSFM, and tissue slices are captured with an UltraMicroscope II 
LSFM for high resolution (Step 6). The data is stitched, volumes fused, and rendered in 3D visualization 
(Step 7).



Figure 2. Vessel labelling with dextran solution by active perfusion
(a) Photo of dissected human kidney with inserted tubing (scale bar: 1 cm). (b) The tubing was changed 
to be PTFE (chemical-resistant, anti-adhesive, biocompatible) tube and tightly fixed by double rope-
fastening (red rectangle in c). (d) The inserted nozzle of PTFE tube was cut with a slope angle to plug-in 
smoothly. (e) A set of connecting tubing contained the black pump reference tube in the middle, two white 
tubes at both ends, tube connectors and a pipette. The red arrows indicated the flow circulation direction. 
(f) Vessel labelling with dextran solution using pump perfusion system (rotation of the wheel in g enables 
solution flow into kidney, black pump reference tube was fastened by correct set up of cassette shown in 
h). (i) Photos of human kidney after dextran labelling. (j) The dextran labeled human kidney was sealed in 
a plastic bag. 
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Figure 3. Organ mounting and imaging with light-sheet microscopy
(a) Photo of human pancreas before clearing (scale bar: 1 cm). (b) Photo of transparent human pancreas
after PI cell nuclei labelling and clearing, showing mesenteric artery (white arrow) and lymph nodes
(yellow asterisk) (scale bar: 1 cm). (c) The mounting of an organ on a sample holder required glue and
black tape. The red arrows show the moving range ends of holder in Y direction. (d) The sample holder
was gummed with four sections of tape and dropped with glue. (e) One example of sample position with
one end alignment to cover one sample edge. (f) Another example of sample position with another end
alignment to cover the other sample edge. (g) The mounted human pancreas was illuminated by light
sheet.
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Figure 4. 3D reconstruction of human pancreas
(a) 3D reconstruction of human pancreas imaged by light sheet fluorescence microscopy focusing on the
PI labeled cell nuclei (Green) and autofluorescence of 785 nm wavelength (magenta) (scale bar: 1 cm).
(b) Zoomed 3D reconstruction in figure A showed the vessels and lymph nodes (red rectangular) (scale
bars: 1 mm and 200um respectively). (c) 3D reconstruction of one example of endocrine portion by high
magnification of 12X objective (scale bar: 200 um). (d) Diverse islets surrounded by acinar cells could be
easily identified in 3D images of endocrine portion showing standard round or oval shape and irregular
shapes as well as variable sizes (red asterisk). Also, intralobular ducts could be located near the islets
(yellow arrow). (scale bars: 50 um, 50 um and 30um, respectively).
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Figure 5. SHANEL of human organs with perfusion of dextran vessel labelling dye 
(a) Human heart after SHANEL protocol (i), 3D reconstruction (ii) shows blood vessels of coronary artery 
(red) and myocardium which can be imaged in autofluorescence at 488 nm (AF, green) (scale bars: 1 cm 
and 2mm, respectively).  (b) Human kidney after SHANEL (i), structure of glomeruli can be seen in 
dextran labelled. TO-PRO3 labelled cell nucleus (scale bars: 1 cm and 2mm, respectively). (c) One lobe 
of human lung was cleared and stained with dextran, bronchus can be seen in AF (scale bars: 1 cm and 
2mm, respectively).  (d) Image of human pancreas and vasculature after SHANEL (scale bars: 1 cm and 
2mm, respectively). (e) Human spleen after SHANEL, fine structure of splenic artery was visualized in 
Imaris (scale bars: 1 cm and 2mm, respectively). 
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Figure 6. SHANEL of human tissues by passive incubation
(a) 3D reconstruction of skull labelled with lectin (yellow) and PI (blue) (i). XY section (ii) and magnified 
image (iii) (scale bars: 1mm, 1mm and 100um, respectively). (b) brain slice labelled with Neurotrace Nissl 
stain (scale bars: 2mm and 300um, respectively). (c) brain tissue labelled with Iba1 antibody (i). YZ (ii) 
and XZ (iii) section, magnified image in XY section (iv) (scale bars: 1000 um, 700 um, 500 um and 40 um, 
respectively). (d) human lung tissue labelled with α-SMA antibody (i). YZ (ii) and XZ (iii) section, magnified 
image in XY section (iv) (scale bars: 700 um, 500 um, 500 um and 150 um, respectively).
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Figure 7.  Passive incubation, clearing and 3D reconstruction of human pulvinar and skull
(a) Photo of transparent human pulvinar after PI cell nuclei labelling and clearing by passive incubation 
(scale bar: 1 cm). (b) 3D reconstruction of human pulvinar imaged by light-sheet fluorescence microscopy 
focusing on autofluorescence (AF) of 488 nm wavelength (grey) and PI labeled cell nuclei (Green) (scale 
bar: 1 cm). (c) section view of pulvinar showing the connection between bone tissue and the pulvinar 
fibrofatty tissue (scale bar: 150 um). (d) Human skull bone after PI cell nuclei labelling and clearing (scale 
bar: 1 cm).  (e) The human skull imaged by light-sheet and confocal microscopy (Scale bar 500 um and 
200 um, respectively).
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Supplementary Figure 1. Human brain clearing by perfusion system
(a) The dissection of human brain with CL and CR (left and right carotids, respectively), VL and VR (left 
and right veterbral arteries, respectively). (b) The human brain after dissection and fixation. (c) The set up 
of human brain clearing by perfusion system under fume hood. The human brain was put in a glass 
container and connected with input and output tubing controlled by peristaltic pump. There were four 
channels to control the four connecting tubings as indicated in C i. Two output tubings were connected 
with the carotids arteries as shown in C ii and two output tubings were connected with the vertebral 
arteries as shown in C iii. The input tubings were protected with gauze to avoid solid impurities entering 
and blocking the tubings (see C iv). C v showed the decolorization effects of CHAPS/NMDEA according 
to the blooming of dark green color from the organ. (d) The glass container was sealed with several 
layers of plastic wrap to prevent the volatility of running solutions, especially for EtOH, DCM, MeOH. (e) 
Photo of human brain after SHANEL pretreatment before clearing. Remaining blood in the vessels (b) 
was decolorized.



Supplementary Figure 2. Passively stained conjugated antibody in centimeter-size human kidney 
and lung tissue 
Collagen IV, catalase and cytokeratin 19 antibody staining (Green) in human kidney (a) and lung (b). Top 
panel shows immunofluorescent staining images in confocal microscopy to verify antibody compatibility 
with SHANEL. Bottom panel shows 3D reconstruction of tissue with antibody labelling in Imaris. (scale 
bars: 20 um and 500 um, respectively)
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Supplementary Figure 3. Settings in imaging software
(a) The user interface of Lavision Imspector software. (i) refer to the setting of objective lens and 
magnification. (ii) The names of the devices should be listed in the correct order. (iii) One example for 
settings of the tiling scan with 4x7 tiles and 33% overlap.
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Supplementary Figure 4. Key steps for data stitching, renaming and compression
(a) One example for correcting information of ‘Stitching Image Grid Sequence’, and a1 highlighted the 
replacement of red letters in step x about ‘file names’. (b) The key information of ‘TileConfiguration’ txt file, 
b1 highlighted the responding channel number should be corrected and saved in respective separated 
folder and b2 highlighted the starting Z number should be ‘0000’ for all ‘TileConfiguration’ files. (c) The 
information of ‘Stitching.py’. (d) One example for settings of ‘Multi-Rename Tool’. (e) One example of 
compressing tiff files with ‘LZW TIFF’.
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Supplementary Figure 5. Key steps for Arivis fusion of 3D images
(a) One example of flipping one volumetric data of X or Y or Z direction to match with another volumetric 
data. (b) The overview of two volumetric data showing same XYZ directions after flipping. (c-d) Examples 
of identical structural markers from two volumetric data sets for fusion. (e) Loading of three key markers 
for best fusion. (f) 3D fused image of pancreas from two volumetric data sets.
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Supplementary Figure 6. Key steps for Imaris data loading and visualization
(a) One example of converting stitched image sequence data to the .ims format using Imaris File 
Converter. (b) The settings for file names with delimiter should be changed into “C _ Z.tif”. (c) 3D image 
properties including XYZ voxel size and channel color can be set in Imaris for analysis.
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Supplementary Figure 7. Overview of SHANEL workflow 
This workflow summarizes the main steps after organ collection: experimental setup (yellow), 
pretreatments (blue), labelling and clearing (grey) and imaging (red). We provided two ways of handling 
samples: active perfusion with pump, if the vessels could be connected with external tube, and passive 
incubation with shaker. Moreover, depending on the organ components, organ size, targeted labelling, 
and imaging structurers, we outlined the differences in the whole process.
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